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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/
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Support

Mercury Product Support

You can obtain support information for products formerly produced by Mercury as follows:

• If you work with an HP Software Services Integrator (SVI) partner (www.hp.com/
managementsoftware/svi_partner_list), contact your SVI agent.

• If you have an active HP Software support contract, visit the HP Software Support Web 
site and use the Self-Solve Knowledge Search to find answers to technical questions.

• For the latest information about support processes and tools available for products 
formerly produced by Mercury, we encourage you to visit the Mercury Customer Support 
Web site at: http://support.mercury.com.

• If you have additional questions, contact your HP Sales Representative.

HP Software Support

You can visit the HP Software Support Web site at:

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract. To find more information about access levels, go to: 
www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to: 
www.managementsoftware.hp.com/passport-registration.html
4

www.hp.com/go/hpsoftwaresupport
www.hp.com/managementsoftware/svi_partner_list
www.hp.com/managementsoftware/svi_partner_list
http://support.mercury.com
www.hp.com/managementsoftware/access_level
www.managementsoftware.hp.com/passport-registration.html


Table of Contents

Welcome to This Guide .........................................................................9
How This Guide Is Organized .............................................................10
Who Should Read This Guide .............................................................12
Documentation Library.......................................................................12
Additional Online Resources...............................................................16
Typographical Conventions................................................................17

Chapter 1: Introduction to Service Test Management.......................19
About Service Test Management .........................................................19
The Service Test Management Integrated Solution ............................20
Advantages of Service Test Management ............................................21

Chapter 2: The Service Test Management Process ............................23
Creating Services and Service Groups .................................................24
Generating Requirements and Tests ...................................................25
Editing Tests Using HP Service Test ....................................................25
Running Service Tests and Viewing Results ........................................26
Updating Services and Analyzing Changes.........................................27
Rerunning Service Tests to Verify Changes ........................................27

Chapter 3: Setting Up Service Test Management ..............................29
Requirements for Service Test Management.......................................30
The Installation Process.......................................................................30
Installing Service Test Management ...................................................32
Loading the Service Test Management License ..................................41
Enabling the Service Test Management Extension.............................42
Installing the Service Test Add-in for Quality Center.........................43
The Generated Requirements Configuration File ...............................45
Uninstalling Service Test Management...............................................47
5



Table of Contents
Chapter 4: Customizing Service Test Management ...........................55
About Customizing Service Testing ....................................................56
Customizing the Services Module.......................................................57
Customizing User Group Permissions ................................................59
Customizing Module Access for User Groups.....................................61
Customizing Project Entities...............................................................62

Chapter 5: Getting Started with the Services Module .......................63
Accessing the Services Module ............................................................64
The Services Module Window.............................................................65
Services Menu Bar................................................................................66
Services Toolbars .................................................................................67
Service Repository and Service Groups Tabs.......................................68

Chapter 6: Creating Services...............................................................71
About Creating Services ......................................................................72
Working with Toolkits ........................................................................72
Creating a Services Tree.......................................................................73
Importing Service Definitions .............................................................74
Creating Requirement Coverage for Services......................................86
Accessing Services on Secure Sites and Proxy Servers .........................90
Creating Manually Defined Services ...................................................93

Chapter 7: Managing Services ............................................................95
About Managing Services ....................................................................96
Viewing and Modifying Services.........................................................97
Finding Folders and Services ...............................................................98
Copying Folders and Services..............................................................99
Managing Service Definitions ...........................................................100
Managing Service Details ..................................................................103
Managing Service Operations ...........................................................105
Associating Service Groups with Services .........................................107
Adding Attachments to Services and Service Groups .......................109
Generating Excel Reports ..................................................................109
Removing and Restoring Services .....................................................111

Chapter 8: Working with Service Groups .........................................115
About Working with Service Groups ................................................115
Creating a Service Group...................................................................116
Creating Requirement Coverage for Service Groups ........................117
Viewing and Modifying Service Group Details.................................120
Viewing and Modifying Services Assigned to Service Groups ..........122
Removing Service Groups .................................................................126
6



Table of Contents
Chapter 9: Generating Service Requirements and Tests..................127
About Generating Service Requirements and Tests ..........................127
Selecting Testing Aspects...................................................................128
Generating Service Requirements and Tests Automatically .............130
Manually Creating a Service Test in Quality Center.........................136
After Generating Requirements and Tests ........................................136

Chapter 10: Linking Services to Requirements.................................139
About Linking Services to Requirements ..........................................139
Viewing the Linked Requirements Tab .............................................141
Linking a Service or Service Group to Requirements........................146
Deleting Requirement Coverage .......................................................147
Viewing the Service Coverage Chart.................................................148

Chapter 11: Linking Tests to Services ...............................................149
About Linking Tests to Services.........................................................149
Viewing the Linked Tests Tab ...........................................................150
Linking Tests to a Service or Service Group ......................................154
Removing Test Coverage ...................................................................158

Chapter 12: Running Service Tests ...................................................161
About Running Service Tests.............................................................162
Viewing and Editing Service Tests.....................................................162
Configuring Run-Time Settings from Quality Center.......................164
Configuring Test Instance Parameters from Quality Center ............167
Creating Tests Sets .............................................................................170
Running Service Tests and Viewing Test Results ..............................171

Chapter 13: Viewing Linked Defects.................................................175
About Viewing Linked Defects ..........................................................175
Viewing Defects Linked to Services or Service Groups .....................176

Chapter 14: Updating Services and Analyzing Service Changes .....179
About Using Change Impact Analysis ..............................................180
The Service Change Workflow..........................................................181
Updating Services and Service Groups..............................................182
Viewing Service Changes...................................................................185
Creating Test Sets ..............................................................................189
Running Test Sets ..............................................................................191
Updating the Change and Service Status ..........................................192
7



Table of Contents
Appendix A: Integration with HP Service Test................................. 193
Creating Tests with HP Service Test.................................................. 193
Creating a Service Emulation............................................................ 194
Using Emulated Services in Vuser Scripts ......................................... 203
Emulating Services from Quality Center .......................................... 205

Index ................................................................................................. 207
8



Welcome to This Guide

Welcome to HP Service Test Management, a complete solution for managing 
the process of testing services and service changes in service-oriented 
architecture (SOA) systems. Service Test Management integrates with 
HP Quality Center to provide a Web-based solution for testing the quality 
and performance of SOA services throughout the entire application 
development lifecycle. 

Note: This guide explains how to manage service tests in conjunction with 
Quality Center. For additional information on using Quality Center, refer to 
the HP Quality Center User’s Guide.

This chapter describes: On page:

How This Guide Is Organized 10

Who Should Read This Guide 12

Documentation Library 12

Additional Online Resources 16

Typographical Conventions 17
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How This Guide Is Organized

This guide contains the following chapters:

Chapter 1 Introduction to Service Test Management

Provides an introduction to the Service Test Management model and its 
integration with Quality Center.

Chapter 2 The Service Test Management Process

Describes the typical Service Test Management workflow.

Chapter 3 Setting Up Service Test Management

Describes the installation requirements and setup procedures for using 
Service Test Management in the Quality Center application.

Chapter 4 Customizing Service Test Management

Describes how to customize the Services module, user group permissions, 
module access, and project entities for services and service groups.

Chapter 5 Getting Started with the Services Module

Describes the key elements in the Services module interface, including the 
various tabs.

Chapter 6 Creating Services

Describes how to create a services tree, import service definitions, create 
requirement coverage for services, access services on secure sites and proxy 
servers, and manually define services in the services tree.

Chapter 7 Managing Services

Describes how to view and modify service details, definitions, and operation 
data, generate Excel reports, remove and restore services and service groups, 
and associate services groups with services.
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Welcome to This Guide
Chapter 8 Working with Service Groups

Describes how to create service groups, create requirement coverage for 
service groups, and assign services to service groups.

Chapter 9 Generating Service Requirements and Tests

Describes how to use the Requirement and Test Generation wizard to 
automatically generate test requirements and test cases.

Chapter 10 Linking Services to Requirements

Describes how to link requirements to services or service groups in the 
Linked Requirements tab. Also describes requirements coverage.

Chapter 11 Linking Tests to Services

Describes how to link tests to services or service groups in the Linked Tests 
tab.

Chapter 12 Running Service Tests

Describes how to edit tests and test configuration settings. Also describes 
how to create and run tests, and view test results.

Chapter 13 Viewing Linked Defects

Describes how to view defects linked to your services and service groups and 
track the progress of defect resolution.

Chapter 14 Updating Services and Analyzing Service Changes

Describes how to identify changes in services and analyze their impact on 
related assets in Quality Center. Also describes how to create and run test 
sets to test the impact of these changes.

Appendix A Integration with HP Service Test

Describes how HP Service Test integrates with Service Test Management to 
let you create tests and emulated services to check and assess the quality of 
applications and services in your SOA systems.
11
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Who Should Read This Guide

This guide is intended for IT managers, IT architects, QA managers, and 
functional and performance QA engineers.

This guide assumes that you are knowledgeable about Quality Center and 
highly skilled in constructing and running functional tests using 
HP QuickTest Professional, and in constructing and running load tests using 
HP LoadRunner or HP Performance Center.

Documentation Library

The Documentation Library is an online help system that describes how to 
use the application. When using Service Test Management in the 
Quality Center application, you can access the Quality Center 
Documentation Library or the Service Test Management Documentation 
Library.

➤ Quality Center Documentation Library. When working in any module other 
than the Services module, you can access the Quality Center 
Documentation Library in the following ways:

➤ Click Documentation Library in the Help menu to open the 
Quality Center Documentation Library home page. The home page 
provides links to the Quality Center guides and references.

➤ Click Help on this page in the Help menu to open the Documentation 
Library to the topic that describes the current page.

➤ Service Test Management Documentation Library. When working in the 
Services module, you can access the Service Test Management 
Documentation Library by clicking Help on this page in the Help menu and 
then clicking the Home page. The Service Test Management Documentation 
Library home page provides links to the Service Testing guides.
12
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The Documentation Library is best viewed from a browser with Java 
support. If you do not have Java support on your browser, download the Sun 
Java plug in from the Sun Java Web site (http://java.com/en/index.jsp). Note 
that if Java support is not available, the Documentation Library 
automatically opens using the JavaScript implementation. The JavaScript 
implementation provides the same basic functionality as the Java 
implementation, however does not allow use of the Favorites tab within the 
navigation pane.

Quality Center Documentation Library Guides

The Quality Center Documentation Library consists of the following guides 
and references, available online, in PDF format, or both. PDFs can be read 
and printed using Adobe Reader which can be downloaded from the Adobe 
Web site (http://www.adobe.com).

Getting Started explains how to use the Documentation Library and how it 
is organized. (Available online.)

What’s New? describes the newest features in the latest versions of 
Quality Center. (Available online and in PDF format.)

You can also access the What’s New? from the Quality Center Help menu. In 
addition, you can choose Help > Product Feature Movies to view short 
movies which demonstrate the main product features. 

Readme provides last-minute news and information about Quality Center. 

Quality Center Guides:

HP Quality Center User’s Guide explains how to use Quality Center to 
organize and execute all phases of the testing process. It describes how to 
define requirements, plan tests, run tests, and track defects. (Available 
online and in PDF format.)

HP Quality Center Administrator’s Guide explains how to create and 
maintain projects using Site Administration, and how to customize projects 
using Project Customization. (Available online and in PDF format.)
13
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HP Quality Center Tutorial is a self-paced guide teaching you how to use 
Quality Center to manage the software testing process. (Available in PDF 
format.)

HP Quality Center Installation Guide explains how to install Quality Center 
on a server machine in a cluster environment or as a stand-alone 
application. (Available in PDF format.)

Business Process Testing Guides:

HP Business Process Testing User’s Guide explains how to use Business 
Process Testing to create business process tests. (Available online and in PDF 
format.)

HP Business Process Testing Tutorial provides a self-paced guide that teaches 
you the basics of Business Process Testing in the Quality Center application. 
(Available in PDF format.)

API References:

HP Quality Center Database Reference provides a complete online reference 
for the project database tables and fields. (Available online.)

HP Quality Center Open Test Architecture API Reference provides a 
complete online reference for the Quality Center COM-based API. You can 
use the Quality Center open test architecture to integrate your own 
configuration management, defect tracking, and home-grown testing tools 
with a Quality Center project. (Available online.)

HP Quality Center Site Administration API Reference provides a complete 
online reference for the Site Administration COM-based API. You can use 
the Site Administration API to enable your application to organize, manage, 
and maintain Quality Center users, projects, domains, connections, and site 
configuration parameters. (Available online.)

HP Quality Center Custom Test Type Guide provides a complete online 
guide on how to create your own testing tool and integrate it into the 
Quality Center environment. (Available online.)
14
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Note: A Service Test Management API reference (HP Quality Center Service 
Test Management API Reference) is also available upon request from HP 
Customer Support (http://support.mercury.com) or your HP Service Test 
Management supplier. It provides an online reference for the Service Test 
Management COM-based API. You can use the API to integrate your own 
SOA implementation tools and home-grown testing tools with a Quality 
Center project for which the Service Test Management extension is enabled.

Service Test Management Documentation Library Guides

The Service Test Management Documentation Library consists of the 
following guides, available online, in PDF format, or both. PDFs can be read 
and printed using Adobe Reader which can be downloaded from the Adobe 
Web site (http://www.adobe.com).

Readme provides last-minute news and information about Service Test 
Management.

Service Testing Guides:

HP Service Test Management User’s Guide explains how to use Service Test 
Management to facilitate the complete application delivery lifecycle in SOA 
environments. (Available online and in PDF format.)

HP Service Test User’s Guide explains how to use Service Test to create 
scripts for SOA environments. (Available in PDF format only.)
15
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Additional Online Resources

The following additional online resources are available from the 
Quality Center Help menu:

Knowledge Base uses your default Web browser to open the Mercury 
Customer Support Web site directly to the Knowledge Base landing page. 
Choose Help > Knowledge Base. The URL for this Web site is 
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp.

Customer Support Web site uses your default Web browser to open the 
Mercury Customer Support Web site. This site enables you to browse the 
Mercury Support Knowledge Base and add your own articles. You can also 
post to and search user discussion forums, submit support requests, 
download patches and updated documentation, and more. Choose Help > 
Customer Support Web site. The URL for this Web site is 
http://support.mercury.com.

HP Software Web site uses your default Web browser to access the HP 
Software Web site. This site provides you with the most up-to-date 
information on HP Software products. This includes new software releases, 
seminars and trade shows, customer support, and more. Choose 
Help > HP Software Web site. The URL for this Web site is 
www.hp.com/managementsoftware.

Add-ins Page opens the HP Quality Center Add-ins Page which offers 
integrations with HP testing tools as well as third-party, synchronization, 
and version control tools. For more information, refer to the 
HP Quality Center Installation Guide.
16
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Typographical Conventions

This guide uses the following typographical conventions:

UI Elements and 
Function Names

This style indicates the names of interface elements on 
which you perform actions, file names or paths, and 
other items that require emphasis. For example, “Click 
the Save button.” It also indicates method or function 
names. For example, "The wait_window statement has 
the following parameters:"

Arguments This style indicates method, property, or function 
arguments and book titles. For example, “Refer to the 
HP User’s Guide.”

<Replace Value> Angle brackets enclose a part of a file path or URL 
address that should be replaced with an actual value. 
For example, <MyProduct installation folder>\bin.

Example This style is used for examples and text that is to be 
typed literally. For example, “Type Hello in the edit 
box.”

CTRL+C This style indicates keyboard keys. For example, “Press 
ENTER.”

[ ] Square brackets enclose optional arguments.

{ } Curly brackets indicate that one of the enclosed values 
must be assigned to the current argument. 

... In a line of syntax, an ellipsis indicates that more items 
of the same format may be included. In a 
programming example, an ellipsis is used to indicate 
lines of a program that were intentionally omitted.

| A vertical bar indicates that one of the options 
separated by the bar should be selected.
17
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1
Introduction to Service Test Management

Service Test Management provides SOA services testing and validation that 
enable you to improve the quality and manage the complexity associated 
with SOA.

About Service Test Management

In SOA systems, it is essential that you test the stability and quality of your 
applications and services before deployment. Service Test Management, in 
conjunction with other HP testing tools, enables you to test the services you 
employ to ensure that they perform their intended function and scale to 
meet the needs of the applications that use them.

Service Test Management adds a Services module in Quality Center that 
enables you to centrally manage your SOA assets. Using the Services 
module, you can define, import, and store services in Quality Center. After 
you define or import services, you can generate a set of test requirements 
and test cases to validate the functionality, interoperability, security, 
boundaries, standards compliance, and performance of services in your SOA 
environment. 

This chapter describes: On page:

About Service Test Management 19

The Service Test Management Integrated Solution 20

Advantages of Service Test Management 21
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Chapter 1 • Introduction to Service Test Management
You can then run services tests and view results in the Test Plan module and 
Test Lab module of Quality Center. Service Test Management also provides 
service change analysis that highlights changes in SOA environments and 
evaluates the impact that changes in a service may have. Based on these 
changes, Service Test Management can automatically generate the necessary 
test cases that need to be run.

The Service Test Management Integrated Solution

Service Test Management is an integrated solution that allows you to 
manage the quality of services in SOA systems. It integrates the following 
HP products:

➤ HP Quality Center. Enables you to centrally manage SOA assets from the 
Services module. You can define, import, and store services in 
Quality Center, and generate the necessary test requirements and test cases.

➤ HP Service Test. Enables you to automatically create test scripts for testing 
your SOA environment. You can edit tests generated using Service Test 
Management, run tests, view results, reuse services, and create an emulation 
of a Web service for testing purposes.

➤ HP LoadRunner/HP Performance Center. Enable you to perform load testing 
on services, and monitor and predict their performance under load. 
HP LoadRunner Analysis allows you to drill down to determine the specific 
source of bottlenecks and generate actionable reports.

➤ HP QuickTest Professional. Enables you to perform functional testing of 
services. It supports WSDL validation so that QA can import descriptions of 
Web services and create tests to validate them. QA engineers can ensure that 
services are in compliance with corporate standards so they can be reused 
across multiple applications.

➤ HP Systinet Registry. Enables you to import services from the HP Systinet 
Registry (supports Systinet 2 with Service Pack 1 and later).
20
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Advantages of Service Test Management

Service Test Management provides major advantages in testing SOA services 
that enable you to benefit from: 

➤ a complete testing process that includes functional testing and performance 
testing

➤ automatically generated requirements and tests that validate the 
functionality (positive and negative), interoperability, standards 
compliance, security, and performance of a service

➤ reusable test cases that can be combined and extended across teams, 
providing easier transfer of knowledge and test case data

➤ change impact testing that highlights changes in SOA services and 
environments and evaluates the impact that changes in a service may have 
on different applications

➤ automatic script generation using WSDL/client recording 
validation/regression

➤ existing LoadRunner scripts that can be reused without any changes in 
Service Test. Similarly, scripts created in Service Test that can be reused in 
LoadRunner

➤ non-GUI testing that enables SOA services to be tested earlier in the 
development cycle

➤ service emulation so you can create a service whenever it is not available, 
and parameterize its response so that it can be used for early test creation
21
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2
The Service Test Management Process

This chapter gives you an overview of the Service Test Management process 
for testing services in a SOA environment.

You can perform service testing by following the process below. 

Creating Services and Services 
Groups 

Generating Requirements and 
Tests

Running Service Tests and 
Viewing Results

Updating Services and 
Analyzing Changes

Editing Tests Using
HP  Service Test

Rerunning Service Tests To 
Verify Changes
23



Chapter 2 • The Service Test Management Process
Creating Services and Service Groups

You create services in the Services module by adding services from your SOA 
environment to the services tree. You can add services by importing service 
definitions associated with WSDL files from a file, URL, UDDI or Systinet 
server. A service definition includes the service’s name in the WSDL, the 
WSDL file location, service address (endpoint), service operations, and 
operation parameters. Alternatively, you can manually define services if you 
are using services that are not WSDL-based, or if you have no WSDLs 
available to test.

When you import or define a service, Service Test Management adds the 
service to the services tree and automatically stores the service definition in 
the Quality Center repository. You can define other details and attributes of 
the service in the Services tabs. For more information on importing and 
defining services, see Chapter 6, “Creating Services.” For more information 
on managing services, see Chapter 7, “Managing Services.”

You link services to other Quality Center entities (tests, test sets, and defects) 
through requirement coverage. When you import a service, you can link it 
to a new or existing requirement, a default requirement created by Service 
Test Management, or you can link it later. After you have linked a service to 
a requirement, all other Quality Center entities that are linked to the 
requirement are indirectly linked to the service. For more information on 
requirement coverage, see “Creating Requirement Coverage for Services” on 
page 86.

After you import or define a service, you can assign it to service groups. 
Service groups allow you to organize related services into logical groupings. 
You might, for example, organize services into groups representing different 
physical deployments, business processes or transactions, or application 
types such as Enterprise Resource Planning (ERP) or Customer Relationship 
Management (CRM). For more information on creating service groups, and 
linking related services to these groups, see Chapter 8, “Working with 
Service Groups.”
24
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Generating Requirements and Tests

You start the testing cycle by selecting the aspects you want to test for a 
service or group of services using the Requirement and Test Generation 
wizard. You can generate requirements and tests that validate the 
functionality, interoperability, standards compliance, boundaries, and 
performance of services in your SOA environment. For more information on 
generating requirements and tests, see Chapter 9, “Generating Service 
Requirements and Tests.”

After you select the testing aspects, Service Test Management creates a set of 
requirements and tests specifying which parts of the SOA environment to 
test and what to test in each part. You can refine the generated requirements 
and tests to suit your specific testing objectives. You can also link services to 
other manually created requirements and tests. For more information on 
linking services to requirements, see Chapter 10, “Linking Services to 
Requirements.” For more information on linking tests to services, see 
Chapter 11, “Linking Tests to Services.”

Editing Tests Using HP Service Test

After Service Test Management generates tests, you can review the tests 
using Service Test to determine their suitability to your testing goals. If 
necessary, you can refine the generated tests to expand their scope and 
purpose. You can add and remove service operation invocations, update 
argument data, add validation steps on service responses, and configure 
security and attachment data. For more information on using Service Test to 
edit service tests, see “Viewing and Editing Service Tests” on page 162. 

You can also view the script’s run-time settings and customize the way the 
script is run. If a script has parameters, you can assign values to them, or 
change the existing parameter values from within Quality Center. For more 
information, see “Configuring Run-Time Settings from Quality Center” on 
page 164 and “Configuring Test Instance Parameters from Quality Center” 
on page 167.
25



Chapter 2 • The Service Test Management Process
Running Service Tests and Viewing Results

Before running service tests, you create test sets containing the service tests. 
You can then run service tests and view results in the Test Lab module of 
Quality Center. 

When you run a service test, Service Test opens and runs the test under the 
test configuration. When the test finishes, it reports the test results back to 
Quality Center, and saves them as part of the test run. You can view the 
results in various formats:

➤ View a report for each script action and a replay log from the Execution 
Grid. For more information, see “Viewing the Test Results Report and Log 
File” on page 172.

➤ View the results using Quality Center graphs, reports, and documents. For 
more information, refer to the HP Quality Center User’s Guide.

➤ View service level status through requirement coverage. The view is based 
on the relation of a service or a group of services to a requirement. The 
requirement status is defined from the test execution status. For more 
information, see “Viewing the Service Coverage Chart” on page 148.

➤ Export Quality Center data to Microsoft Excel. This enables you to use Excel 
to analyze your data and present it in graphical form. For more information, 
see “Generating Excel Reports” on page 109.

For more information on running and viewing test results, see Chapter 12, 
“Running Service Tests.”

After running a service test, you can create defects and link them to tests or 
requirements that cover the service or service group. For more information 
on linking defects to services, see Chapter 13, “Viewing Linked Defects.” 
26
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Updating Services and Analyzing Changes

You can reduce the risk of changes in SOA environments by checking for 
service updates. Service Test Management checks for updates by comparing 
the current WSDL file to the WSDL file stored in Quality Center. If there are 
updates, Service Test Management identifies any changes to the service and 
establishes their impact.

To verify the changes, you can create test sets containing all tests linked to 
the updated service, or only those tests that are using service operations 
affected by the changes. For more information on change impact analysis, 
see Chapter 14, “Updating Services and Analyzing Service Changes.”

Rerunning Service Tests to Verify Changes

After creating test sets, you can run the affected tests in the test set to verify 
whether these changes caused regression in service functionality and 
performance. 

After all the changes have been successfully tested and you are satisfied with 
the quality of a service, you can update the service change status. For more 
information on creating and running test sets to verify changes, see 
Chapter 14, “Updating Services and Analyzing Service Changes.”
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3
Setting Up Service Test Management

This chapter describes the installation requirements and setup procedures 
for using Service Test Management in the Quality Center application.

This chapter describes: On page:

Requirements for Service Test Management 30

The Installation Process 30

Installing Service Test Management 32

Loading the Service Test Management License 41

Enabling the Service Test Management Extension 42

Installing the Service Test Add-in for Quality Center 43
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Uninstalling Service Test Management 47
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Requirements for Service Test Management

To use Service Test Management 9.2, you must have the following installed:

➤ Quality Center 9.2 (on your server machine).

➤ Quality Center 9.2 Patch 1 (on your server machine).

➤ Service Test 9.0 or the Service Test Add-in for Quality Center 9.2 (on your 
client machine).

The minimum system requirements to run Service Test Management are the 
same as for Quality Center, as described in the HP Quality Center Installation 
Guide.

The Installation Process

This section describes the Service Test Management installation process.

To install Service Test Management:

 1 Ensure that Quality Center 9.2 is installed on your server machine.

For more information on installing Quality Center, refer to the 
HP Quality Center Installation Guide.

 2 Install Quality Center 9.2 Patch 1 on your server machine.

Quality Center 9.2 Patch 1 is provided on the Service Test Management 
installation DVD. To install the patch, follow the on-screen installation 
instructions.

 3 Install Service Test Management 9.2 on your server machine.

For more information on installing Service Test Management, see “Installing 
Service Test Management” on page 32.

 4 Load the Service Test Management licence.

For more information, see “Installing the Service Test Add-in for 
Quality Center” on page 43.
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 5 Enable the Service Test Management extension in Quality Center Site 
Administration for every project that requires Service Test Management.

For more information, see “Enabling the Service Test Management 
Extension” on page 42.

 6 Install Service Test 9.0 or the Service Test Add-in for Quality Center 9.2 on 
each client machine.

To use all the features in Service Test Management, Service Test 9.0 or the 
Service Test Add-in for Quality Center 9.2 must be installed on each client 
machine from which you want to use the extension. Earlier versions of 
Service Test or the Service Test Add-in for Quality Center are not compatible 
with Service Test Management 9.2.

For more information on installing Service Test 9.0, refer to the HP Service 
Test Installation Guide. For more information on installing the Service Test 
Add-in, see “Installing the Service Test Add-in for Quality Center” on 
page 43.
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Installing Service Test Management

The setup program provides a wizard that guides you through the 
installation.

To install Service Test Management:

 1 Insert the Service Test Management installation DVD into the DVD drive 
and run the appropriate file.

 2 The Welcome dialog box opens. Click Next.

 3 The License Agreement dialog box opens.

Read the license agreement. To accept the terms of the license agreement, 
select I accept the terms of the license agreement.

Click Next.

Platform To install:

Windows Run the setup.exe file.

Solaris or Linux
(console mode)

➤ To install on a Solaris platform, type:
./setupSolaris.bin -console 

➤ To install on a Linux platform, type:
./setupLinux.bin -console

Solaris or Linux
(UI mode)

Make sure that the DISPLAY environment variable is 
properly configured on the Quality Center host machine, 
and that the machine from which you are installing is 
running an X-server (for example, Exceed). 

➤ To install on a Solaris platform, type:
./setupSolaris.bin

➤ To install on a Linux platform, type:
./setupLinux.bin
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 4 The Directory Name dialog box opens.

Accept the proposed folder for the Service Test Management installation or 
browse for an alternate folder.

Click Next.
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 5 The HP Quality Center Repository Path dialog box opens.

Type the location of the Quality Center repository. The default 
Quality Center repository path is displayed by default.

Click Next.
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 6 The Installation Summary dialog box opens.

To review or change any settings, click Back.

To accept the settings and start the installation, click Next. The installation 
process starts.
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 7 When the installation process completes, the Update Server dialog box 
opens.

When you update the Quality Center server, the Service Test Management 
files are copied into the opened archive directories (qcbin.war and 
sabin.war) in the <Quality Center Installation>\application directory, and 
the Quality Center Archive and Deployment Tool is launched. This tool 
enables you to update the running Quality Center Web server.

Note: This step does not affect the Quality Center server until the files are 
packed into the archive directories and deployed into the Quality Center 
Web server directories (during the deployment stage).

Select an update option:

➤ Update now. To update the Quality Center archive files and launch the 
deployment tool now.

➤ Update later. To manually update the Quality Center server at a later 
time. You must update the Quality Center server before you can use 
HP Service Test Management.

Click Next. 
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 8 If you selected Update now, proceed to step 9.

If you selected Update later, click Next and then click Finish to close the 
installation setup dialog box. When you are ready to update the application 
server, run the deploy.bat script (or deploy.sh for Solaris or Linux) from the 
<Service Test Management installation> directory. When running the batch 
file, specify the Quality Center installation directory and the location of the 
Quality Center repository, using the format:

deploy <Quality Center installation directory> <Quality Center repository 
directory>

For example:

deploy "C:\Program Files\Mercury\Quality Center" "C:\Program 
Files\Mercury\Quality Center\repository"

 9 After clicking Update now or manually launching the batch file, the 
Quality Center Archive and Deployment Tool opens.
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For Service Test Management to work with Quality Center, you need to 
create a new archive and redeploy the qcbin.war and sabin.war files on the 
application server. This enables changes to the archive files to take effect. 
Note that it takes more time to create qcbin.war than sabin.war.

Click Next to create the new archive files.

 10 If your application server is JBoss, proceed to step 11.

If your application server is other than JBoss, the following dialog box 
opens.

You must deploy Quality Center manually on the application server after 
the setup process completes. The location of the archive files is shown in the 
dialog box. 

The updated archive files are stored in different formats, although the 
content is the same. The files are stored openly in the 10sabin.war and 
20qcbin.war folders, and as closed archives in sabin.war and qcbin.war. 
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Note: For more information on manually deploying Quality Center on an 
application server, refer to the HP Quality Center Installation Guide.

Click Next and proceed to step 13.

 11 If your application server is other than JBoss, proceed to step 13.

If your application server is JBoss, the HP Quality Center Redeployment 
dialog box opens.

Choose one of the following options:

➤ Yes. To deploy the archive files automatically.

➤ No. To manually deploy the archive files later.

Click Next.
39



Chapter 3 • Setting Up Service Test Management
 12 If the Quality Center service is running, the Archive and Deployment Tool 
automatically attempts to stop the service. If the tool is unable to stop the 
service, the Service not stopped dialog box opens.

Choose one of the following options:

➤ Retry. To try again to stop the JBoss service.

➤ Skip JBoss deployment. To cancel the deployment and manually deploy 
JBoss later.

Click Next.

 13 When the deployment is complete, the Completion dialog box opens. Click 
Finish to close the Quality Center Archive and Deployment Tool.

Note: If you manually deployed the archive files on your application server, 
you must restart Quality Center after deployment. 

 14 Click Finish to close the HP Service Test Management Setup dialog box.
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Loading the Service Test Management License

After installing Service Test Management on your Quality Center server, you 
must load your Service Test Management license to enable the Services 
module in Quality Center.

To load the Service Test Management license:

 1 In Site Administration, click the Licenses tab.

 2 Click the Modify License button. The License Edit dialog box opens.

 3 Click the Load License button and select the Service Test Management 
license file. Alternatively, copy the license file and click Paste License.

 4 Click OK. The SOA license is displayed in the list of HP Quality Center 
licenses.
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Enabling the Service Test Management Extension

After loading the Service Test Management license, you must enable the 
Service Test Management extension for a project before you can use it with 
the project. Note that you cannot disable an extension for a project after 
you enable it.

To enable the Service Test Management extension for a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project. In the right pane, click the Project 
Extensions tab. This tab is available only if you have a license for at least one 
extension and the extension is installed on the Quality Center server. The 
Extensions list is displayed, listing extensions installed on the 
Quality Center server.

 3 Select the Enabled check box for the HP Service Test Management 
extension, and click Yes to confirm.

 4 To refresh the Extensions list, click the Refresh button.
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Installing the Service Test Add-in for Quality Center

The Service Test Add-in for Quality Center provides extended functionality 
to Service Test Management, enabling you to do the following in the 
Services module:

➤ Import service WSDL files from a file system, URL, UDDI or Systinet server.

➤ Import service WSDL files that reside in secure locations or that are accessed 
through proxy servers.

➤ Generate requirements and tests using the Requirement and Test Generation 
wizard.

➤ Perform service change analysis.

Note: The functionality provided by the Service Test add-in is included in 
Service Test. If you have already installed Service Test on your 
Quality Center client machine, or you intend to install it before using 
Service Test Management, you do not need to install this add-in. For more 
information on installing Service Test, refer to the HP Service Test User’s 
Guide.

If you do not install the add-in, you can still use the Services module in 
Viewer mode. This mode is suitable for business services users, such as QA 
managers and SOA architects who want to view data on the service quality 
process, create service coverage, link services to requirements and tests, and 
produce service reports.

You can install the Service Test Add-in for Quality Center from the following 
locations:

➤ Service Test Management installation DVD. To install the add-in, run the 
HPServiceTestPlugin90.exe file. 

➤ Quality Center Add-ins page. For more information, see “Installing the Add-
in from the Quality Center Add-ins Page” on page 44.

➤ Customer Support site (http://support.mercury.com). You can access the 
Customer Support site by choosing Help > Customer Support Web Site.
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Installing the Add-in from the Quality Center Add-ins 
Page
You can install the Service Test Add-in from the Quality Center Add-ins 
page.

Note: To install this add-in, you must log in with administrator privileges.

To install the add-in from the Quality Center Add-ins page:

 1 Open your Web browser and type your Quality Center URL: 

http://<Quality Center server name>[<:port number>]/qcbin. The 
HP Quality Center Options window opens.

 2 Click the Add-ins Page link. The Quality Center Add-ins page opens.

 3 Click the More HP Quality Center Add-ins link. The More HP Quality Center 
Add-ins page opens.

 4 In the Quality Center Administrator Add-ins section, under HP Tool Add-ins, 
click the HP Service Test Add-in for Quality Center link. The HP Service Test 
Add-in for Quality Center page opens.

 5 Click the Download HP Service Test Add-in for Quality Center 9.2 link to 
download the add-in. 

 6 Follow the on-screen installation instructions.
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The Generated Requirements Configuration File

The RequirementGen.xml file stores the configuration data for requirements 
generated using the Requirement and Test Generation wizard. It contains 
the properties of the requirements that are generated for each testing aspect 
and sub-aspect, and it is unique for every project. 

When you create a new project, the RequirementGen.xml file is created in 
the new project's repository under the services folder. The 
RequirementGen.xml configuration file contains the following information:

You can change the default fields and the requirement parameter values in 
this file. For more information, see “Customizing the Requirements 
Configuration Data” on page 46.

Section Description

Default Values The default values of the fields and parameters that 
are used as properties of the requirements.

Field The value of a database field of the requirement. For 
example, RQ_REQ_TYPE.

Param The value of a parameter that are used in one of the 
requirement's properties. For example, 
%req_priority%.

Service The requirement that is generated for the service. 
This requirement is used as the parent of all the 
requirements that are generated for the testing 
aspects. If this section is missing, the aspect 
requirements are generated as the children of the 
requirement that was selected in the wizard.

Aspects The properties of the requirements that are 
generated for the aspect. In addition, it contains the 
list of sub-aspects.

SubAspect The properties of the requirements that are 
generated for the sub-aspects.

Requirement The properties of the generated requirement. This 
includes the requirement name, description, and 
any other relevant fields.
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Customizing the Requirements Configuration Data
You can change the requirement name, description, parameter values, and 
other fields for requirements and customize them using Quality Center 
Open Test Architecture.

Tip: Alternatively, you can customize the configuration data using the 
Requirement Generation Configuration Utility which is available from 
Customer Support (http://support.mercury.com).

To customize the configuration file using Quality Center Open Test 
Architecture:

 1 Connect to the project on the Quality Center server.

 2 Obtain a Service Factory object from the TDConnection object.

 3 Download the configuration file from the Quality Center server to a folder 
on the client’s machine. Call LoadRequirementConfig(<the target folder in 
the client’s machine>).

 4 Modify the RequirementGen.xml file using an XML editor.

 5 Upload the configuration file from the client’s machine to the 
Quality Center server. Call SaveRequirementConfig(<the folder in the client’s 
machine which contains the configuration file>).
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Uninstalling Service Test Management

This section describes how to uninstall Service Test Management from your 
Windows, Solaris, or Linux server machine. When you uninstall Service Test 
Management, the Service Test Management files are deleted from 
Quality Center.

To uninstall Service Test Management from Windows:

 1 Make sure that the application server is running.

 2 To open the HP Service Test Management Uninstall dialog box, you can:

➤ Choose Start > Settings > Control Panel > Add/Remove Programs, select 
HP Service Test Management, and click the Change/Remove button. 
Follow the instructions on your screen.

➤ Locate the Service Test Management home directory. By default, the files 
are stored in [drive]:\Program Files\HP\STM. In the _uninst subdirectory, 
double-click uninstall.exe.

The HP Service Test Management Uninstall dialog box opens.
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 3 Click Next. The Update the server dialog box opens.

Select an update option:

➤ Yes. To update the archive files and launch the deployment tool now.

➤ No. To uninstall later.

Click Next to continue to uninstall, or Cancel to uninstall later.
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 4 The Quality Center Archive and Deployment Tool opens.

To uninstall Service Test Management, you need to create a new archive and 
redeploy the Quality Center and Site Administration war files (qcbin.war 
and sabin.war) on the application server. This enables changes to the .war 
files to take effect.

Click Next to create the new archive files.

Note: It takes more time to create qcbin.war than sabin.war.
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 5 If your application server is JBoss, proceed to step 6.

If your application server is other than JBoss, the following dialog box 
opens.

You must deploy Quality Center manually on the application server after 
the setup process completes. The location of the archive files is shown in the 
dialog box. 

The updated archive files are stored in different formats, although the 
content is the same. The files are stored openly in the 10sabin.war and 
20qcbin.war folders, and as closed archives in sabin.war and qcbin.war.

To update the archives and undeploy them manually, run the undeploy.bat 
script (or undeploy.sh for Solaris or Linux) from the <Service Test 
Management installation> directory. When running the batch file, specify 
the Quality Center installation directory and the location of the 
Quality Center repository, using the format:

undeploy <Quality Center installation directory> <Quality Center repository 
directory>
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For example:

undeploy "C:\Program Files\Mercury\Quality Center" "C:\Program 
Files\Mercury\Quality Center\repository"

Note: For more information on manually deploying Quality Center on an 
application server, refer to the HP Quality Center Installation Guide.

Click Next and proceed to step 8.

 6 If your application server is other than JBoss, proceed to step 8.

If your application server is JBoss, the HP Quality Center Redeployment 
dialog box opens.

Choose one of the following options:

➤ Yes. To deploy the archive files automatically.

➤ No. To manually deploy the archive files later. 

Click Next to continue.
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 7 If the Quality Center service is running, the Archive and Deployment Tool 
automatically attempts to stop the service. If the tool is unable to stop the 
service, the Service not stopped dialog box opens.

Choose one of the following options:

➤ Retry. To try again to stop the JBoss service.

➤ Skip JBoss deployment. To cancel the deployment and manually deploy 
JBoss later.

Click Next.
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 8 When the deployment is complete, the Completion dialog box opens. Click 
Finish to close the Quality Center Archive and Deployment Tool Setup. The 
HP Service Test Management Uninstall dialog box is displayed.

 9 Click Next. The Update completed dialog box opens.
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 10 Click Next to continue. 

It is recommended that you click Yes to delete the remaining uninstall files 
in the Service Test Management directory.

Click Next.

 11 Click Finish to close the HP Service Test Management Uninstall dialog box.

To uninstall Service Test Management from Linux or Solaris:

 1 Make sure that the application server is running.

 2 Type the following command at the system prompt:

/[directory]/[Service_Test_Management_directory]/_uninst/uninstall.bin

The Service Test Management Uninstall wizard opens.

 3 Click Next. Follow the on-screen instructions.

 4 Run the Quality Center Archive and Deployment Tool to create a new 
archive and redeploy the Quality Center and Site Administration .war files 
on the application server.

 5 When Service Test Management prompts you to delete all add-in files, select 
Yes.
54



4
Customizing Service Test Management

You can customize the Services module, user group permissions, module 
access, and project entities for services and service groups.

 

This chapter describes: On page:

About Customizing Service Testing 56

Customizing the Services Module 57

Customizing User Group Permissions 59

Customizing Module Access for User Groups 61

Customizing Project Entities 62
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About Customizing Service Testing

You can customize general project data in the Services module. This includes 
specifying default values for services stored in secure locations and on a 
proxy server, the default Systinet and UDDI server information, the toolkit 
parsing order for importing service definitions, and the default requirement 
folder.

You can also customize service and service group entities in the same way as 
you can customize other entities in your Quality Center projects. You can 
restrict which user groups can add, delete and modify folders, services, and 
service groups. You can determine whether user groups can update services 
and service groups, link services and service groups to requirements, and 
emulate services. 

In addition, you can customize access to the Services module for each user 
group, and customize the system fields and add new user-defined fields.

Note: This chapter describes the additional customization options available 
with Service Test Management. For more information on Project 
Customization, refer to the HP Quality Center Administrator’s Guide.
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Customizing the Services Module

You can customize the default connection settings, Systinet server, UDDI 
server, the toolkit order for importing WSDLs, and the default requirement 
folder.

To customize the Services module:

 1 In Quality Center, select Tools > Customize. The Project Customization 
window opens.

 2 Click the Service Test link. The Service Test page opens.
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 3 You can set the default WSDL connection settings for importing a service 
from a secure location and for accessing a service using a proxy server. In the 
Connection Settings section, click Edit Default Settings. The Connection 
Settings dialog box opens. Configure the default connection settings as 
described in “Accessing Services on Secure Sites and Proxy Servers” on 
page 90

 4 You can set the Systinet server details that are displayed by default when a 
user opens the Import a Service from a Systinet Server dialog box. In the 
Default Systinet Server section, type the name and port of the Systinet 
server. Only Systinet 2 with Service Pack 1 or later is supported.

 5 You can set the UDDI server address URL and version that are displayed by 
default when a user opens the Import a Service from a UDDI Server dialog 
box. In the Default UDDI Server section, enter the URL and version of the 
UDDI server.

 6 To set the order in which the toolkits are parsed when importing a WSDL, in 
the Auto-Detect Toolkit Order section, select a toolkit and use the Move 
Toolkit Up and Move Toolkit Down buttons.

 7 You can select the folder in which Service Test Management creates 
requirements when you import services and link them to a default 
requirement. In the Default Requirements section, click the browse button 
and select a folder in the Select Requirements dialog box. You can only 
specify an existing folder for the default requirement location. For more 
information on linking requirements, see “Creating Requirement Coverage 
for Services” on page 86.

 8 Click Save to save your settings to the Service Test page.
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Customizing User Group Permissions

You can customize the permission settings for managing services, service 
groups, folders, updates, and requirement and test linkage from the Services 
tab in the Permission Settings dialog box. For more information on user 
group permissions, refer to the HP Quality Center Administrator’s Guide.

To set user group permissions:

 1 In Quality Center, select Tools > Customize. The Project Customization 
window opens.

 2 Click the Groups link. The Groups page opens.

 3 In the Groups list, choose the user group for which you want to set 
permissions.

 4 Click the Change button. The Permission Settings dialog box open.

 5 Click the Services tab.
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The Services tab displays the following tasks that are available in the Services 
module:

 6 Select the tasks that the selected user group can use.

Task Description

Add Service User group can add services to the Services module. 

Modify Service User group can modify services in the Services 
module. Note that this task enables you to specify 
the fields that the selected user group can modify.

Delete Service User group can delete services from the Services 
module. 

Link Service to 
Requirements

User group can link services to requirements in the 
Services module. 

Update Service/Group User group can update services or service groups. 
Note that selecting this task automatically enables 
the Modify Service task. 

Add Service Folder User group can add folders to the services tree. 

Modify Service Folder User group can modify folders in the services tree. 
Note that this task enables you to specify the fields 
that the selected user group can modify.

Delete Service Folder User group can delete folders from the services tree.

Add Group User group can add service groups to the Services 
module. 

Modify Group User group can modify service groups in the Services 
module. Note that this task enables you to specify 
the fields that the selected user group can modify.

Delete Group User group can delete service groups from the 
Services module. 

Link Group to Requirements User group can link service groups to requirements 
in the Services module. 

Emulate Services User group can emulate services from 
Quality Center.
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 7 Click OK to close the Permission Settings dialog box.

 8 Click Save to save your settings to the Groups page.

Customizing Module Access for User Groups

After you enable the HP Service Test Management extension for a project, 
you can control access to the Services module for each user group. You can 
enable access to all Quality Center modules including the Services module, 
or to all Quality Center modules excluding the Services module. 

For more information on customizing module access for user groups, refer to 
the HP Quality Center Administrator’s Guide.

To customize Services module access for user groups:

 1 In the Project Customization window, click the Module Access link. The 
Module Access page opens.

The  icon indicates the modules that the user group can access.

To select or clear a cell in the table, double-click the cell, or select the cell 
and press the space bar.
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 2 To select the Defects module only, select the Defects Module column. This 
clears all the other columns.

 3 To select the Quality Center modules (including the Defects module), select 
the Quality Center column. This clears the Defects Module column.

 4 To select the Services module, select the Services column. This selects the 
Quality Center column and clears the Defects Module column.

 5 Click Save to save your changes.

Customizing Project Entities

You can customize the system fields and add new user-defined fields from 
the Project Entities page. You customize service fields under the Service 
entity, and service group fields under the Service Group entity. 

For more information on customizing project entities, refer to the 
HP Quality Center Administrator’s Guide. For detailed information on 
Quality Center entities and fields, refer to the HP Quality Center Database 
Reference.

To customize project entities:

 1 In Quality Center, select Tools > Customize. The Project Customization 
window opens.

 2 Click the Project Entities link. The Project Entities page opens.

 3 Under Project Entities, expand the Service or Service Group entity.

 4 Customize the system and user-defined fields as required.

 5 Click Save to save your settings to the Project Entities page.

To view user-defined fields for a service or service group, select the Details 
tab for the service or service group, and then select the Addition Fields tab 
below the Description box.
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Getting Started with the Services Module

The Services module enables you to create and manage services and service 
groups, and generate service requirements and tests in Quality Center.

This chapter describes: On page:

Accessing the Services Module 64

The Services Module Window 65

Services Menu Bar 66

Services Toolbars 67

Service Repository and Service Groups Tabs 68
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Accessing the Services Module

You create and manage services and service groups, and generate service 
requirements and tests in Quality Center from the Services module.

To access the Services module:

 1 Log in to your Quality Center project. The Quality Center main window 
opens. For more information on logging in to Quality Center, refer to the 
HP Quality Center User’s Guide.

 2 Click the Services button on the sidebar of the Quality Center window. The 
Services module opens. For more information on the Services module 
window, see “The Services Module Window” on page 65.

If the Services button is not displayed in the sidebar:

➤ Check with your system administrator that you are connected to a 
Quality Center server with Service Test Management. If Service Test 
Management is not installed on your current Quality Center server, 
disconnect and reconnect to a server with Service Test Management.

➤ Check that Service Test Management licenses are currently available on 
the Quality Center server. Contact your Quality Center Site 
Administrator or refer to the HP Quality Center Administrator’s Guide.
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The Services Module Window

The Services module window is shown below.

The Services module contains the following key elements:

➤ Services menu bar. Contains menus with Services module commands. For 
more information, see “Services Menu Bar” on page 66.

➤ Service Repository/Service Groups toolbar. Contains buttons for frequently 
used commands in the Service Repository and Service Groups tabs. For more 
information, see “Services Toolbars” on page 67.

➤ Service Repository tab. This tab is located in the left pane below the toolbar. 
It displays services folders and individual services in your project, organized 
in a graphical hierarchy in the services tree. The services tree enables you to 
construct and organize your services folders and individual services. For 
more information, see Chapter 6, “Creating Services” and Chapter 7, 
“Managing Services.”
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➤ Service Groups tab. This tab is located in the left pane below the toolbar. It 
displays the service groups in your project in a list view. The service groups 
list enables you to organize your services into service groups, and perform 
tasks on an entire service group. For more information, see Chapter 8, 
“Working with Service Groups.”

➤ Service Repository/Service Groups tabs. These tabs are located at the top of 
the right pane. They provide a complete overview of the service, service 
folder, or service group’s content. For more information, see “Service 
Repository and Service Groups Tabs” on page 68.

Services Menu Bar

The Services menu bar contains the following menus:

➤ Services. Contains commands that enable you to create services and services 
folders, update services, restore services, show/hide changed services, and 
generate requirements and tests. (This menu is enabled only when the 
Services tab is selected.)

➤ Groups. Contains commands that enable you to create new service groups, 
update service groups, and generate requirements and tests. (This menu is 
enabled only when the Service Groups tab is selected.)

➤ Edit. Contains commands that enable you to cut, copy, paste, find, delete, 
and rename services, services folders, and service groups.

➤ View. Contains commands that enable you to expand and collapse services 
folders, filter, sort, and refresh services.

➤ Tools. Contains commands that enable you to emulate services using the 
Service Emulation tool. For more information on service emulation, see 
“Creating a Service Emulation” on page 194.
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Services Toolbars

The Services toolbars contain buttons for frequently-used commands in the 
Service Repository tab and Service Groups tab. The toolbar buttons differ 
according to the tab selection.

Service Repository Toolbar
The Service Repository toolbar contains the following buttons:

New Folder. Adds a new folder to the services tree below the currently 
selected item.

Import Service/Create Definition Manually. Enables you to import a service 
definition based on a WSDL file or manually define a service. For more 
information on importing service definitions and manually defining 
services, see Chapter 6, “Creating Services.”

Delete. Removes the currently selected folder or service from the services 
tree. Deleting a services folder also deletes its subfolders and all of the 
services in the folders.

Any removed service that is linked to a test is moved to the Obsolete folder 
in the tree. Unused services are permanently deleted. For more information 
on working with the Obsolete folder, see “Removing and Restoring Services” 
on page 111.

Refresh Selected. Refreshes the data for the currently selected folder or 
service.

Set Filter/Sort. Enables you to locate required service tree items by setting 
filter or sort preferences. For more information on filtering and sorting, refer 
to the HP Quality Center User’s Guide.

Service Groups Toolbar
The Service Groups toolbar contains the following buttons:

New Group. Adds a new group to the service groups list.

Delete. Removes the currently selected service group from the service groups 
list.
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Refresh Selected. Refreshes the data in the service groups list.

Service Repository and Service Groups Tabs

These tabs provide a complete overview of a service, a services folder, or a 
service group’s content. The following tabs are available in the right pane of 
the Services module when the Service Repository or Service Groups tab is 
selected:

➤ Description tab. Enables you to add or view a textual description of the 
folder contents. You can add or modify the text in the Description box. 
(This tab is displayed only when you select a services folder.)

➤ WSDL Definition tab. Displays data that is required to identify the selected 
service, including service address, WSDL location, and service name. For 
more information, see “Managing Service Definitions” on page 100.

➤ Details tab. Displays general details and attributes of the selected service or 
service group. For more information, see “Managing Service Details” on 
page 103 and “Viewing and Modifying Service Group Details” on page 120.

➤ Operations tab. Displays service operation data for the selected service. For 
more information, see “Managing Service Operations” on page 105.

➤ Groups tab. Displays a list of groups that are linked to the selected service. 
You can view, add, and delete groups in the groups grid. The tab includes an 
icon  if the selected service is associated with service groups. For more 
information, see “Associating Service Groups with Services” on page 107.

➤ Services tab. Displays a list of services that are linked to the selected group. 
You can view, add, and delete services assigned to groups in the assigned 
services grid. The tab includes an icon  if the selected group has services 
assigned to it. For more information, see “Viewing and Modifying Services 
Assigned to Service Groups” on page 122.

➤ Linked Req tab. Displays a list of requirements that are linked to the selected 
service or service group. You can add and remove requirements linked to 
services and service groups. The tab includes an icon  if the selected 
service or service group has requirement coverage. For more information, 
see “Linking Services to Requirements” on page 139.
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➤ Linked Tests tab. Displays a list of tests that are linked to the selected service 
or service group through requirement coverage. The tab includes an icon  
if the selected service or service group has linked tests. For more 
information, see “Linking Tests to Services” on page 149.

➤ Linked Defects tab. Displays a list of defects that are linked to the selected 
service or service group through requirement coverage. It also displays 
defects that are linked to tests, that are linked to the selected service or 
service group. The tab includes an icon  if the selected service or service 
group has linked defects. For more information, see “Viewing Linked 
Defects” on page 175.

➤ Changes tab. Displays a list of changes in the selected service. The tab 
includes an icon  that indicates that changes have been made to the 
service, and the service should be reviewed. For more information, see 
“Viewing Service Changes” on page 185.

➤ Attachments tab. Displays a list of files that have been associated with the 
selected service as attachments. The tab includes an icon  if the selected 
service has attachments. For more information, see “Adding Attachments to 
Services and Service Groups” on page 109.
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6
Creating Services

You create services by importing service definitions, or by manually defining 
services in the Service Repository tab of the Services module.

This chapter describes: On page:

About Creating Services 72

Working with Toolkits 72

Creating a Services Tree 73

Importing Service Definitions 74

Creating Requirement Coverage for Services 86

Accessing Services on Secure Sites and Proxy Servers 90

Creating Manually Defined Services 93
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About Creating Services

You create services in the Services module by adding services to the services 
tree. You can add services in two ways: you can import service definitions 
based on a WSDL file, or you can manually define services. 

You can import a service definition from a file location, URL, UDDI or 
Systinet server. You specify the WSDL source file location, a toolkit for 
parsing the WSDL file, and a requirement coverage option for linking the 
service to a requirement. Requirement coverage is required to connect the 
service to other Quality Center entities, such as tests, test sets, and defects. 

You can also import a WSDL that resides in a secure location, or that is 
accessed through a proxy server. Once you enter the security or proxy 
information, it remains with the WSDL, enabling service updates and 
automatic synchronization. When you import a service definition, Service 
Test Management extracts the service name, service address (endpoint), and 
operations data from the WSDL file, and stores it in the Quality Center 
repository. 

If you are using services that are not WSDL-based, or if you have no WSDLs 
available to test, you can create service definitions manually. When you 
define a service manually, Service Test Management creates an empty 
definition, and allows you to update the attributes.

After you import or define a service, you can view and modify information 
about the service in the Services. For more information, see Chapter 7, 
“Managing Services.”

Working with Toolkits

You can select a toolkit before importing a service definition, and Service 
Test Management imports the service definition using that toolkit. Service 
Test Management supports the .NET version 1.1, Axis version 1.3 Web 
Service, and a Generic toolkit. The Generic toolkit emulates a general toolkit 
that should be used when the other toolkits cannot be used, for example, 
when unexpected errors are encountered. 
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When selecting a toolkit, you should match the toolkit to the actual 
development environment. After you select a toolkit, it becomes 
permanently associated with the service definition.

Alternatively, you can instruct Service Test Management to detect the 
appropriate toolkit to use using Auto-detect (the default setting). 
Auto-detect attempts to parse the selected WSDLs using the available 
toolkits, according to the toolkit parsing order set in Project Customization. 
For more information on customizing the toolkit parsing order, see 
“Customizing the Services Module” on page 57. 

Creating a Services Tree

Services are organized in a graphical hierarchy in the services tree of the 
Service Repository tab. You can organize related services in folders and 
subfolders, and drag and drop folders or subfolders to other folders in the 
tree. 

At the top level of the services tree is the Services root folder, which 
contains the services folders. Under the Services root folder, you can create 
custom folders that represent various services structures. For example, you 
might create separate folders to represent services for different applications.

The Obsolete folder contains services that have been removed from the 
services folders but are still being used by tests stored in Quality Center. For 
more information on the Obsolete folder, see “Removing and Restoring 
Services” on page 111. 

You cannot rename, move, or delete the Services folder or the Obsolete 
folder.

To create a services folder in the services tree:

 1 Click the Services button in the sidebar. The Services module opens.

 2 Click the Service Repository tab in the left pane.

 3 Select the Services root folder, or another folder in the services tree.
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 4 Click the New Folder button in the tree toolbar. The New Folder dialog box 
opens.

 5 Enter a descriptive name in the Folder Name box and click OK. A service 
folder name cannot include any of the following characters: \ ^ *.

The new folder is displayed under the folder you selected in step 3.

 6 You can add a textual description of the folder contents in the Description 
tab.

Importing Service Definitions

You can import (and later update) service definitions based on WSDL files 
from a file location, URL, UDDI or Systinet server. You can also import 
WSDL files that reside in secure locations, and WSDL files accessed through 
proxy servers by supplying the relevant authentication credentials. For more 
information, see “Accessing Services on Secure Sites and Proxy Servers” on 
page 90.

When you import a service, you can link it to an existing requirement, a 
new requirement, a default requirement that Service Test Management 
creates for you, or you can link it later. Requirement coverage connects 
services to other Quality Center entities (tests, test sets, and defects), which 
helps you to keep track of the service and ensure compliance with your 
requirements throughout the testing process. For more information on 
requirement coverage, see “Creating Requirement Coverage for Services” on 
page 86.
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Note: If a WSDL file has multiple service definitions, a service entity is 
created for each definition.

To import a service definition:

 1 Click the Service Repository tab in the left pane.

 2 In the services tree, select the folder into which you want to import the 
service definition.

 3 Choose Services > New Service > Import Service. The Import Services dialog 
box opens.
75



Chapter 6 • Creating Services
 4 In the Import WSDL from section, select an import option:

➤ File. Imports a service definition based on a WSDL file from a file system.

➤ URL. Imports a service definition based on a WSDL file from a URL.

➤ UDDI. Imports a service definition based on a WSDL file from a UDDI 
server.

➤ Systinet. Imports a service definition based on a WSDL file from a 
Systinet server. 

 5 Click Add, and follow the import procedures for the selected option.

➤ For importing from a file, see “Importing Service Definitions from a File 
System” on page 79.

➤ For importing from a URL, see “Importing Service Definitions from a 
URL” on page 80.

➤ For importing from a UDDI, see “Importing Service Definitions from a 
UDDI Server” on page 81.

➤ For importing from Systinet, see “Importing Service Definitions from 
Systinet” on page 84.

 6 After selecting the service definitions you want to import, the selected 
services are displayed in the Import Services dialog box.

 7 In the Import with toolkit box, select the toolkit for parsing the WSDL file 
from the toolkits list. To instruct Service Test Management to detect the 
appropriate toolkit, select Auto-detect (the default setting). For more 
information on selecting a toolkit, see “Working with Toolkits” on page 72.

 8 In the Requirement linkage area, select an option for linking the selected 
services to a requirement.

➤ Existing requirement. Enables you to link the services to a new or 
existing requirement in the requirements tree. 

➤ Default requirement. Enables you to link the services to a default 
requirement created by Quality Center.

➤ Link later. Enables you to link the service later. 

For more information on the requirement linkage options, see “Creating 
Requirement Coverage for Services” on page 86.
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 9 Connection settings enable you to set credentials required to access a WSDL 
located on a secure site, and to access a WSDL using a proxy server. To 
configure connection settings, click Configure, and follow the instructions 
described in “Accessing Services on Secure Sites and Proxy Servers” on 
page 90. If connections settings are specified, they are displayed in the 
Connection Settings box.

Note: You cannot configure connection settings for a service definition 
imported from a file system or a Systinet server.

 10 Click Import to import the selected service definitions. The Import Services 
dialog box opens and the import process begins.

To automatically close the Import Services dialog box after the import 
process has finished, select Close dialog box when process finishes.
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By default, Quality Center pauses the process each time it finds an error, and 
displays the error message in the Import Services dialog box. To continue 
with the import process, click Continue, or click Stop to end the process. If 
you do not want to view errors during the import process, clear the Pause on 
error check box.

 11 To stop the import process at any time, click Stop.

 12 When the import process has finished, click Finish to close the Import 
Services dialog box.

The successfully imported services are added to the services tree below the 
folder you selected in step 2 with the following icon:

Icon Command

Import WSDL from File

Import WSDL from URL

Import WSDL from UDDI

Import WSDL from Systinet

Create Definition Manually
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Importing Service Definitions from a File System
You can import service definitions based on WSDL files from a file system by 
browsing the file system, and selecting the files you want to import.

To import service definitions from a file system:

 1 After performing steps 1-5 of “Importing Service Definitions” on page 74, 
the Open dialog box opens with Files of type set to WSDL files (*.wsdl and 
*.xml).

 2 Browse to the directory where the WSDL files are located, select the files you 
want to import, and click Open. The Open dialog box closes, and the files 
are added to the import services list in the Import Services dialog box.

Tip: You can also import service definitions by pressing the INSERT key and 
typing the file path and name directly into the import services list.

 3 To add WSDL files from other directories, click Add, and repeat this process.
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 4 To remove a service from the WSDL list in the Import Services dialog box, 
select the service and click Remove.

 5 Continue with step 6 of “Importing Service Definitions” on page 74.

Importing Service Definitions from a URL
You can import service definitions based on WSDL files from a URL, by 
browsing Web pages and selecting the desired URL, or by typing the URL 
directly.

To import service definitions from a URL:

 1 After performing steps 1-5 of “Importing Service Definitions” on page 74, a 
Web browser opens.

 2 In the Address box, type the URL, or navigate to the URL in Internet 
Explorer.

 3 Close the browser. The selected URL is added to the import services list in 
the Import Services dialog box.

Tip: You can also import service definitions based on URLs by pressing the 
INSERT key and typing the URL directly into the import services list.

 4 To import services from other URLs, click Add, and repeat this process.

 5 To remove a service from the WSDL list in the Import Services dialog box, 
select the service and click Remove.

 6 Continue with step 6 of “Importing Service Definitions” on page 74.
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Importing Service Definitions from a UDDI Server
You can import service definitions based on WSDL files from a UDDI server. 
You can search for services published on a UDDI server by typing a name or 
part of a name. 

To import a service definition from a UDDI:

 1 After performing steps 1-5 of “Importing Service Definitions” on page 74, 
the Search for Service in UDDI dialog box opens.

 2 You can use the default UDDI service address and version if this was set in 
Project Customization, or type the service name in the UDDI server inquiry 
address box and select the Version used to query the server. For information 
on setting the default UDDI service address and version, see “Customizing 
the Services Module” on page 57.

To restore the default UDDI server inquiry service address and version, click 
Restore Defaults.
81



Chapter 6 • Creating Services
 3 In the Service name (all or part of name) box, type the service name you 
want to search for in the UDDI registry.

The following options are available:

➤ To search for services that exactly match the search text, select 
Exact match.

➤ To search for services that match the case of the text string, select 
Case sensitive.

➤ To search for any string of characters in UDDI Version 2 or 3, use the 
percentage (%) wildcard. For example, A% finds all services that begin 
with the letter A. In addition, in UDDI Version 3, you can use an 
underscore (_) to indicate any value for a single character, and a 
backslash (\) as an escape character for the percentage sign, underscore, 
and backslash characters.

 4 Click Search. The search results are displayed in the service results grid in 
the right pane.

The search results display the following information:

Field Description

Service Name The service name in the UDDI server.

Service Key The unique identifier for the service on the UDDI 
server.

Service Description The description of the service in the UDDI server.

Service WSDL The location of the WSDL file.
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Note: If a service found in the search does not reference a WSDL file, the 
service is not listed in the search results, and a warning message is displayed.

 5 Select the service definitions you want to import and click OK. The Search 
for Service in UDDI dialog box closes and the services are added to the UDDI 
services list in the Import Services dialog box.

 6 To perform another UDDI search, click Replace All, and repeat steps 1-5.

Note: If you perform another Systinet search, the services selected in the 
previous search will be lost.

 7 To remove services from the UDDI services list in the Import Services dialog 
box, select the services and click Remove.

 8 Continue with step 6 of “Importing Service Definitions” on page 74.
83



Chapter 6 • Creating Services
Importing Service Definitions from Systinet
You can import service definitions based on WSDL files from a Systinet 
server. Systinet is a complete governance solution that provides a 
standards-based means for publishing and discovering reusable business 
services and SOA artifacts. You can define services in Systinet, and reuse 
these definitions for managing service testing. 

Note: Only a Systinet 2 server with Service Pack 1 or later is supported.

To import a service definition from Systinet:

 1 After performing steps 1-5 of “Importing Service Definitions” on page 74, 
the Search for Service in Systinet dialog box opens.

 2 You can use the default Systinet service address and port if this was set in 
Project Customization, or type the Systinet server address and Port used to 
query the server. For information on setting the default Systinet service 
address and port, see “Customizing the Services Module” on page 57. To 
restore the default Systinet server address and version, click Restore 
Defaults.
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 3 In the Service name (all or part of name) box, type the term you want to 
search for in the Systinet registry. This term is searched in the Systinet 
service name, description, and other relevant data fields.

The following options are available:

➤ To search for services that exactly match the search text, select 
Exact match.

➤ To search for services that match the case of the text string, select 
Case sensitive.

➤ To search for any string of characters, use the asterix (*) wildcard. For 
example, A* finds all services that begin with the letter A.

 4 Click Search. The search results are displayed in the service results grid in 
the right pane. You can customize data by specifying which columns are 
displayed. Quality Center saves your customized column settings.

The search results display the following information:

Note: If a service found in the search does not reference a WSDL file, the 
service is not listed in the search results, and a warning message is displayed.

Field Description

Service Name The service name in the Systinet registry.

Service ID The unique identifier for the service in the Systinet 
registry.

Service Description The description of the service in the Systinet 
registry.

Service WSDL The location of the WSDL file.
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 5 Select the service definitions you want to import and click OK. The Search 
for Service in Systinet dialog box closes and the services are added to the 
Systinet services list in the Import Services dialog box.

 6 To perform another Systinet search, click Replace All, and repeat steps 1-5.

Note: If you perform another Systinet search, the services selected in the 
previous search will be lost.

 7 To remove services from the Systinet list in the Import Services dialog box, 
select the services and click Remove.

 8 Continue with step 6 of “Importing Service Definitions” on page 74.

Creating Requirement Coverage for Services

Service Test Management does not support direct links between services and 
tests, test instances, test sets, and defects. Instead, you link services to these 
Quality Center entities through requirement coverage. When you link a 
service to a requirement, all other Quality Center entities that are linked to 
the requirement are indirectly linked to the service. Requirement coverage 
helps you keep track of the relationship between your requirements and 
services, and ensures compliance with your requirements throughout the 
testing process.

When you import a service, you can link it to an existing requirement, a 
new requirement that you create manually, or a default requirement that 
Service Test Management automatically creates for you. Alternatively, you 
can delay linking requirements until after the import process, and link 
services manually in the Linked Requirements tab. Note that you cannot 
link a service to a test or test instance until you have created requirement 
coverage. For more information on manually linking requirements in the 
Linked Requirements tab, see “Linking a Service or Service Group to 
Requirements” on page 146. 
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When you link a service to a requirement, Service Test Management creates 
a Testing requirement type for the service in the Requirements module. For 
more information on requirement types, refer to the HP Quality Center User’s 
Guide.

Linking Services to a New or Existing Requirement
To add requirements coverage to imported services, you can select an 
existing requirement from the requirement tree, or add a new requirement 
anywhere in the tree.

To link a service to a new or existing requirement:

 1 Select the services you want to import as described in steps 1-6 of 
“Importing Service Definitions” on page 74. The selected services are 
displayed in the Import Services dialog box.

 2 In the Requirement linkage section, select the Existing requirement option, 
and click the browse button. The Select Requirement dialog box opens.
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 3 To search for a specific requirement in the tree, type the name (or part of the 
name) of the requirement in the Find box and click the Find button. If the 
search is successful, the requirement is highlighted in the tree.

 4 To filter and sort requirements in the tree, click the Set Filter/Sort button. 
For more information on filtering and sorting a tree, refer to the 
HP Quality Center User’s Guide.

 5 To refresh a requirement in the tree, select the requirement and click the 
Refresh Selected button.

 6 To add a requirement folder, click the New Folder button. For more 
information on creating requirement folders, refer to the HP Quality Center 
User’s Guide. 

 7 To add a requirement, click the New Requirement button. For more 
information on creating requirements, refer to the HP Quality Center User’s 
Guide.

 8 Select a requirement to link to the selected services, and click OK. The 
requirement location is displayed in the requirement box.

When you import services, Service Test Management creates a link between 
the requirement (in the Requirements module) and each service. 
Requirement coverage for each service is displayed in the Linked 
Requirements tab.

Linking Services to a Default Requirement
When you import services, you can link them to a default requirement 
instead of specifying an existing or new requirement. For each imported 
service, Service Test Management creates a requirement with the name 
Default Requirement of Service <service name>(<number>). 

In Project Customization, you can specify a folder in which Service Test 
Management creates default requirements. For information on configuring 
the default requirement folder, see “Customizing the Services Module” on 
page 57.

To link a service to a default requirement:

 1 Select the services you want to import as described in steps 1-6 of 
“Importing Service Definitions” on page 74. The selected services are 
displayed in the Import Services dialog box.
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 2 In the Requirement linkage section, select the Default requirement option.

 3 Click OK. Service Test Management creates a linked requirement for each 
imported service in the Linked Requirements tab.

Delaying Service Requirement Linkage
You can delay linking services to requirements until after the import service 
process is complete. Note that a service must be linked to a requirement 
before you can link it to a test, test instance, or test set.

To delay service requirement linkage:

 1 Select the services you want to import as described in steps 1-6 of 
“Importing Service Definitions” on page 74. The selected services are 
displayed in the Import Services dialog box.

 2 In the Requirement linkage section, select the Link later option.

 3 Click OK. The services are imported without any requirement linkage.

After importing services, you can create requirement coverage by:

➤ Manually linking services to requirements as described in “Linking a 
Service or Service Group to Requirements” on page 146.

➤ Linking services to a Default Requirement when you create test or test set 
coverage. For more information on creating test coverage, see “Linking 
Tests to a Service or Service Group” on page 154. For more information 
on creating test set coverage, see “Creating Test Sets” on page 189.
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Accessing Services on Secure Sites and Proxy Servers

When importing WSDL files from a URL, UDDI server, or Systinet server, the 
WSDL may require authentication if it resides in a secure location. 
Occasionally, access to the WSDL may be through a proxy server. Service 
Test Management supports the importing of WSDLs using security and 
WSDLs accessed through proxy servers.

After you enter the security or proxy information, it remains with the 
WSDL, visible through the Connection Settings box in the Import Services 
dialog box. If you enable the Keep up to date option to allow automatic 
synchronization, Service Test Management accesses the WSDL at its source 
using the authentication or proxy server settings.

Service Test Management supports importing WSDLs using security and 
WSDLs accesssed through proxy servers, using basic and NTLM 
authentication. 

It is recommended that you enter the authentication or proxy information 
while importing the WSDL. If however, the settings changed, you can 
modify them through the WSDL Definition tab.

Note: You can set the default WSDL connection settings in the Project 
Customization window. For more information on customizing the 
connection settings, see “Customizing the Services Module” on page 57.

To configure the connection settings:

 1 Select the WSDLs you want to import as described in “Importing Service 
Definitions” on page 74.

Note: You cannot configure connection settings for a service definition 
imported from a file system or a Systinet server.
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 2 In the Connection Settings section, click Configure. The Connection 
Settings dialog box opens.

 3 To specify authentication details for accessing a WSDL on a secure site, in 
the Authentication section, select Access the WSDL, located in a secure 
location, using the following authentication credentials, and choose one of 
the following authentication options:

Option Description

Use default credentials Uses the Windows logon credentials of the user 
logged on to the machine for authentication.

User name and Password Enter the user name and password to be used for 
authentication. Users that are not in the default 
domain must also type the domain before the user 
name. For example, domain1/alex_qc.
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 4 To specify details for accessing a WSDL through a proxy server, in the Proxy 
section, select Access the WSDL using the following proxy server and 
credentials. Type the Proxy server and Port used to access the WSDL, and 
choose one of the following connection options:

 5 Click OK to apply your settings. Once a service has been successfully 
imported, its connection credentials are stored in Service Test Management.

If you attempt to import the secure service before specifying the necessary 
credentials, Service Test Management prompts you to enter the information. 
If you supply the incorrect, or no credentials, Service Test Management is 
unable to import the file.

 6 To update or modify the authentication or proxy connection settings after 
you import a service, click the WSDL Definition tab, and click the 
Connection Settings button. Edit the required fields in the Connection 
Settings dialog box, and click OK.

Option Description

Use default credentials Uses the Windows logon credentials of the user 
logged on to the machine.

User name and Password Enter the user name and password to be used to 
access the proxy server.
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Creating Manually Defined Services

If you are using services that are not WSDL-based, or you have no WSDLs 
available to test, you can create empty service definitions under the active 
folder, and manually update the service attributes. This enables you to link 
existing requirements and tests to your services. 

To create a manually defined service:

 1 Click the Service Repository tab in the left pane.

 2 In the services tree, select the folder into which you want to create the 
service definition, and choose Services > New Service > Create Definition 
Manually. The New Manual Service dialog box opens.

 3 In the Service Name box, type a name for the service. The service name 
cannot exceed 255 characters or include any of the following characters: % * 
\ | ‘ : “ / < > ? @ # $.

 4 In the Requirement linkage area, select an option for linking the selected 
services to a requirement.

➤ Existing requirement. Enables you to link the services to a new or 
existing requirement in the requirements tree.

➤ Default requirement. Enables you to link the services to a default 
requirement created by Quality Center.

➤ Link later. Enables you to link the service later.

For more information on the requirement linkage options, see “Creating 
Requirement Coverage for Services” on page 86.
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 5 Click Create. The service is added to the services tree below the selected 
folder.

 6 To add a information about the service, click the Details tab, and enter the 
details in the Description box. For more information, see “Managing Service 
Details” on page 103.
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Managing Services

After creating a service, you can view and modify service definitions and 
details, view operations and operation parameters, add attachments, and 
generate Excel reports. You can also remove and restore services and service 
groups and associate services groups with services.

This chapter describes: On page:

About Managing Services 96

Viewing and Modifying Services 97
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Managing Service Definitions 100

Managing Service Details 103
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Associating Service Groups with Services 107

Adding Attachments to Services and Service Groups 109

Generating Excel Reports 109

Removing and Restoring Services 111
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About Managing Services

After you import a service definition or manually define a service, you can 
view and modify service definitions and details. You can also generate Excel 
reports and delete service folders or remove services that are not required.

You can manage service data using the following tabs:

➤ The WSDL Definition tab enables you to view the service definition, 
override the service address, save the WSDL file to another location, and 
modify the connection settings. For more information, see “Managing 
Service Definitions” on page 100.

➤ The Details tab enables you to view and modify general details and 
attributes of the service according to your requirements, including the 
toolkit used, the service creation date, and the user assigned to the service. 
For more information, see “Managing Service Details” on page 103.

➤ The Operations tab enables you to view the service operations and the 
operation’s parameter list for imported services. For more information, see 
“Managing Service Operations” on page 105.

➤ The Groups tab enables you to manually link services to service groups and 
view the service groups to which the service has been assigned. This enables 
you to organize services into logical groupings, and perform tasks on the 
entire service group. For more information, see “Associating Service Groups 
with Services” on page 107.

➤ The Changes tab enables you to keep track of service updates and analyze 
the impact of service changes. For more information, see Chapter 14, 
“Updating Services and Analyzing Service Changes.”

➤ The Attachments tab enables you to associate a file, URL, snapshot, image, 
or system information with a service as an attachment. For more 
information, see “Adding Attachments to Services and Service Groups” on 
page 109.

Note: For information on linking services to other entities, see “Linking 
Services to Requirements” on page 139, “Linking Tests to Services” on 
page 149, and “Viewing Linked Defects” on page 175.
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Viewing and Modifying Services

You can view and modify services and service folders in the services tree. 
When the Services module is first accessed, the services tree displays only 
the highest level folder or services in the hierarchy.

➤ A change alert icon  adjacent to a service indicates that the service status 
has changed. This indicates that changes have been made to the service, and 
these changes should be reviewed. For more information on viewing 
changes, see “Viewing Service Changes” on page 185.

➤ To expand a folder in the tree, click the expand symbol  to the left of the 
folder name, or double-click the folder. Alternatively, choose View > Expand.

➤ To collapse a folder in the tree, click the collapse symbol  to the left of the 
folder name, or double-click the folder. Alternatively, choose View > 
Collapse.

➤ To change a folder or service name in the services tree, select the folder or 
service and click it. Alternatively, choose Edit > Rename. Then edit the item 
name and press ENTER.

➤ To move a folder or service in the tree, you can drag and drop the folder or 
service to the required position in the tree. Alternatively, right-click the 
folder or service, and choose Cut. Then right-click the required folder into 
which to paste the folder or service and choose Paste.

➤ To refresh a folder or service in the tree, select the folder or service and click 
the Refresh Selected button in the toolbar. To refresh all the folders and 
services in the tree, select the Services root folder and click the Refresh 
Selected button in the toolbar.

➤ To filter or sort the services in the tree, click the Set Filter/Sort button in the 
toolbar. Any currently applied filters or sort orders are displayed under the 
service tree toolbar. For more information on filtering and sorting a tree, 
refer to the HP Quality Center User’s Guide.

Note: When defining a cross-filter in Quality Center’s Requirements module 
or Test Plan module, you can filter requirements or tests by linked services.
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Finding Folders and Services

You can search for a particular folder or service in the services tree using the 
Find command. If you have applied filters to the tree, the search is restricted 
to the folders and services currently displayed.

To find a value:

 1 In the services tree, select the folder or service that you want to search, and 
choose Edit > Find. The Find Folder/Service dialog box opens.

The name of the selected folder, or the folder in which the selected service is 
located, is displayed as read-only in the Find in box.

 2 In the Value To Find box, type or select the value to find.

 3 You can select Include Folders to search for the value in all subfolders of the 
selected folder.

 4 You can select Include Services to search for the value in all services in the 
selected folder and its subfolders. If this option is selected, you can choose 
which service types to include in your search.

 5 Click Find. Quality Center attempts to locate the folder or service. If the 
search is successful, the Search Results dialog box opens and displays a list of 
possible matches. Select a result from the list and click the Go To button to 
highlight the folder or service in the services tree. 

If the search is unsuccessful, an information box opens.
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Copying Folders and Services

You can copy an existing service or folder and paste it to another location in 
the services tree, or to another project. When copying a service to another 
project, the source and target projects must be open in separate browsers.

If a copied folder or service has the same name as a folder or service that 
already exists in the target folder or service, a duplicate name warning 
message is displayed. Click OK. The folder or service is copied to the new 
position in the services tree, and a suffix, for example _Copy_1, is 
automatically added to the folder or service name.

Services within folders that are copied in the services tree are also copied. 
You can then use the settings of the copied services as the basis for new 
services.

To copy an existing folder or service:

 1 In the services tree, right-click the folder or service that you want to copy, 
and choose Copy.

 2 Right-click the folder into which you want to paste the new folder or 
services, and choose Paste. The folder or services is copied to the new 
position in the services tree.

 3 If you want to change the name of the copied folder or service, right-click 
the folder or service in the tree, choose Rename, and then enter a new 
name.

 4 To modify settings of the copied service, select the service in the tree, and 
modify the settings in the Services tabs. 
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Managing Service Definitions

You can view the service definition, override the service address, save the 
WSDL file to another location, and modify the connection settings in the 
WSDL Definition tab.

To view or edit a service definition:

 1 Click the Service Repository tab in the left pane.

 2 Select a service in the services tree, and click the WSDL Definition tab.
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The WSDL Definition tab contains the following read-only information:

 3 To change the service name in the services tree, right-click a service and 
choose Rename. Edit the service name and press ENTER.

 4 To override the service address declared in the WSDL file or on the UDDI or 
Systinet server and use a different machine, select the 
Override service/UDDI address/Systinet address check box, and type a 
different address in the Service address box. To revert to the original service 
address, clear the check box.

Tip: Overriding the service address is useful, for example, when the address 
used for a deployed service is different from that used while the service is 
being developed.

Field Description

Service address The service deployment location, to which service 
requests are sent. Quality Center displays by default 
the endpoint address specified in the WSDL file.

WSDL location The location of the WSDL file that is displayed by 
default when importing the service.

Service name The native service name in the WSDL file that is 
displayed by default when importing the service.

UDDI Key A unique identifier of the service on the UDDI 
server, used to locate the service definition when 
updating the service. (Only available for services 
imported from UDDI.) 

WSDL/UDDI/Systinet 
Description

The description of the service in the WSDL file or 
on the UDDI or Systinet server that is displayed by 
default when importing the service.
101



Chapter 7 • Managing Services
 5 To save the WSDL file stored in the Quality Center repository to another 
location, click Download WSDL stored in Quality Center, and select the 
location to which you want to download the file.

Note: A WSDL file may include import directives for other WSDL and XSD 
files. Import directives are stored in Quality Center, and are downloaded 
when the WSDL file is downloaded. The sole purpose of downloading 
import directives is to display what is stored in Quality Center. You should 
not use the import directives to upload the WSDL file, since the import 
locations are redirected and will not work.

 6 To view or modify the authentication or proxy settings for a WSDL, click 
Connection Settings. For more information, on configuring connection 
settings, see “Accessing Services on Secure Sites and Proxy Servers” on 
page 90.

Note: The Connection Settings button is not available for service definitions 
imported from a file system or a Systinet server.
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Managing Service Details

You can view and modify general details and attributes of the service in the 
Details tab. You can change the service details according to your 
requirements by choosing alternative selections from the lists.

To view or modify service details:

 1 Click the Service Repository tab in the left pane.

 2 Select a service in the services tree, and click the Details tab.
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The Details tab contains the following information:

 3 Modify the information as required.

 4 To update the service definition from the WSDL file each time the service is 
loaded, select Keep up to date. For more information on updating services, 
see “Updating Services and Service Groups” on page 182.

Field Description

Toolkit used The name of the Web services toolkit used when 
importing the service.

Created by The user name of the user who created the service.

Creation date The date the service was created in the services tree.

Assigned to The name of the user to whom the service 
implementation is assigned.

Last updated The date and time that the service was last updated.

UDDI server The URL address and version of the UDDI server 
from which the service definition is imported (read-
only).

Systinet server The URL address and port of the Systinet server 
from which the service definition is imported (read-
only).

Deletion date The date the service was deleted (for services in the 
Obsolete folder only).

Deleted from path The path of the deleted service (for services in the 
Obsolete folder only).

Description You can type your own description of the service in 
this box.
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Managing Service Operations

You can view service operations and the operation’s parameter list for 
imported services in the Operations tab. Operations are the various methods 
being exposed by the service. For example, a simple calculator service 
includes an add, divide, multiply, and subtract operation. Parameters are the 
operation request data and response data.

To view service operations:

 1 Click the Service Repository tab in the left pane.

 2 Select a service in the services tree, and click the Operations tab.

The operations grid contains the following information:

Column Description

Name Displays the name of the operation.

Port Displays the port connected to the service for each 
operation.

Description Displays the description of the operation.
105



Chapter 7 • Managing Services
 3 To view the operation’s parameter list, select the operation you want to view 
in the operations grid, and click the View Operation button. Alternatively, 
double-click the operation. The Operation Editor opens displaying a grid of 
the parameters for the operation.

You can proceed through the operations in a service using the browse 
buttons:

➤ Click the First Operation button to display the first operation in the 
service, or the Previous Operation button to display the preceding 
operation.

➤ Click the Next Operation button to display the subsequent operation in 
the service, or the Last Operation button to display the final operation in 
the service.

Click OK to close the Operation Editor.

 4 To export the operations grid data as a text file, Microsoft Excel spreadsheet, 
Microsoft Word document, or HTML document, right-click the grid, choose 
Export to, and select the file type. For more information, refer to the 
HP Quality Center User’s Guide.
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 5 To adjust the row size of an operation, position the mouse pointer on the 
gray sidebar on the lower edge of the operation you want to resize, and click 
and drag the operation to adjust the row size. Click the Adjust Row Height 
button to restore the operation height to the default operation size.

Associating Service Groups with Services

You can associate service groups with services, and view information about 
associated service groups in the Groups tab. You can also go to associated 
service groups in the Service Groups tab.

To associate service groups with services:

 1 Click the Service Repository tab in the left pane.

 2 Select a service in the services tree, and click the Groups tab.

The groups grid contains the following information:

Column Description

Name The group name.

Description A description of the group.

Assigned To The user to whom the group is assigned.
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 3 To set column appearance and order in the groups grid, click the Select 
Columns button. For more information on arranging columns, refer to the 
HP Quality Center User’s Guide.

 4 To go to an associated service group in the Service Groups tab, click the 
group name in the groups grid.

 5 To associate service groups with a service, click the Select button. The 
service groups list is displayed in the right pane. 

 6 To refresh a group in the service groups list, select the group and click the 
Refresh button.

 7 In the service groups list, select the service groups you want to associate 
with the service, and click the Associate Service Group with Service button. 
Alternatively, you can double-click the group, or drag the group to the 
groups grid. The group is added to the groups grid. 

 8 Click the Close Service Groups List button in the upper-right of the service 
groups list to hide the service groups list.

Created By The login name of the user who created the service group.

Creation Date The date on which the group was created.

Column Description
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 9 To remove associated service groups, select the groups to remove, and click 
the Remove Associated Service Group from Service button in the Groups 
toolbar. The association between the selected service groups and the service 
is removed.

Adding Attachments to Services and Service Groups

The Attachments tab enables you to associate an attachment with a service 
or service group. An attachment can be a file, URL, snapshot, an image from 
the clipboard, or system information, and is identified by its name, 
associated application icon, size, and latest modification date and time. You 
can add, modify, and delete attachments. 

The Attachments tab includes an icon  if the selected service or service 
group has any attachments.

The Attachments tab for services and service groups has the same 
functionality as the Attachments tab for other test types. For more 
information on adding attachments, refer to the HP Quality Center User’s 
Guide.

Generating Excel Reports

You can generate Excel reports that enable you to export service and service 
group data to Microsoft Excel and analyze the data from within Excel. This 
enables you to use Excel to analyze your data and present it in graphical 
form. These reports are based on SQL queries performed on the project's 
database, and the results are saved as an Excel file. You can also run a Visual 
Basic script on the extracted data to process and analyze the data.

When using Service Test Management, the following entities are added to 
the entities pane in the Query tab of the Analysis module: Service, Service 
Change, Service Folder, Service Group, Service Group to Requirement 
relation, Service Operation to Component relation, Service Operation to 
Test relation, Service to Group relation, Service to Requirement relation, 
WSDL Operation, and WSDL Operation Parameters. These entities contain 
an Excel Reports folder that stores your SOA-related queries. It also provides 
default queries that you can use to analyze your services.
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For example, you could create a pivot table to summarize Services module 
data, such as to display in tabular format the status count for the different 
service coverage statuses.

You can also display this information in the form of a pie chart report.

For details on how to generate Excel reports, refer to the HP Quality Center 
User’s Guide.
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Removing and Restoring Services

You can delete a folder or remove a service that is not required. Services that 
are not linked to Using tests in Quality Center are permanently deleted. A 
Using test is a test that is actually using the service—it has a call to one or 
more operations of the service and there are links between the services’s 
operations and the test in Quality Center. These links are created when the 
test is saved to Quality Center from Service Test (see “Viewing the Linked 
Tests Tab” on page 150) or when tests are generated using the Requirement 
and Test Generation wizard (see Chapter 9, “Generating Service 
Requirements and Tests”). Services that are linked to one or more Using tests 
in Quality Center are transferred to the Obsolete folder. You cannot copy 
obsolete services.

You can restore services in the Obsolete folder to their original position in 
the services tree if the folder still exists in the tree, or you can drag them to a 
different location in the services tree.

Removing Folders and Services
If you delete a service folder in the services tree, its subfolders and all the 
services in the folders are removed. Services contained in the folders that are 
linked to Using tests in Quality Center are transferred to the Obsolete folder. 
For more information on Using tests, see “Viewing the Linked Tests Tab” on 
page 150.

To remove a service entirely, you must stop all tests from using the service. 
You can stop a test using a service by opening the test in Service Test, and 
removing all Web service calls to the service. After you have removed all 
calls to the service, you can then delete the service from the Obsolete 
directory. 

For more information on viewing linked tests, see Chapter 11, “Linking 
Tests to Services.”

To remove a folder or service:

 1 Click the Service Repository tab in the left pane.

 2 Select the folder or service in the services tree and click the Delete button in 
the toolbar. Click Yes to confirm. 
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The folder or service is removed from the services tree. If services are 
currently linked to Using tests in Quality Center, click Yes to transfer them 
to the Obsolete folder, or click No to cancel the operation.

Tip: To view a removed service in the Obsolete folder in the services tree, 
you must first refresh the folder. Select the Obsolete folder and click the 
Refresh Selected button in the tree toolbar.

Restoring Obsolete Services
You can restore services in the Obsolete folder to their original position in 
the services tree, if the folder still exists in the tree. If the folder no longer 
exists, you can transfer a service to another position in the services tree by 
dragging it from the Obsolete folder to the required position.

To restore a service:

 1 Click the Service Repository tab in the left pane.

 2 In the Obsolete folder in the services tree, select the service you want to 
restore.

 3 To view information on the deleted service, click the Details tab.

The Deletion date box displays the date on which the service was deleted.
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The Deleted from Path box displays the path of the folder where the service 
was last located.

For information about other boxes in the Details tab, see “Managing Service 
Details” on page 103.

 4 To restore the service, choose Services > Restore Service. The service is 
restored to its original location in the services tree.

Alternatively, select the service in the Obsolete folder and drag it to the 
appropriate folder in the services tree. 
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Working with Service Groups

After you create services, you can organize them into logical groupings, and 
perform tasks on the entire service group.

About Working with Service Groups

In an organization, services have a context. For example, services may be 
located on the same server, may be exposed at part of the same application, 
or may take part in the same business process. In the Services module, you 
use the Service Groups tab to create service groups representing logical 
groupings. You might, for example, organize services into groups 
representing different physical deployments, business processes or 
transactions, or application types such as Enterprise Resource Planning 
(ERP) or Customer Relationship Management (CRM). After you create 
service groups, you can assign services to service groups, and perform tasks 
on the entire service group. The same service can be assigned to multiple 
service groups.

This chapter describes: On page:

About Working with Service Groups 115

Creating a Service Group 116

Creating Requirement Coverage for Service Groups 117

Viewing and Modifying Service Group Details 120

Viewing and Modifying Services Assigned to Service Groups 122

Removing Service Groups 126
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Creating a Service Group

Service groups are organized alphabetically in a list in the Service Groups 
tab. Each row in the service groups list displays a separate service group. 

To create a service group:

 1 Click the Service Groups tab in the left pane.

 2 Choose Groups > New Group or click the New Group button in the tree 
toolbar. The New Service Group dialog box opens.

 3 In the Group Name box, enter a descriptive name for the service group 
(maximum length 255 characters). 

 4 In the Requirement linkage area, select an option for linking the selected 
service group to a requirement.

➤ Existing requirement. Enables you to link the service group to a new or 
existing requirement in the requirements tree.

➤ Default requirement. Enables you to link the service group to a default 
requirement created by Quality Center.

➤ Link later. Enables you to link the service group later.

For more information on the requirement linkage options, see “Creating 
Requirement Coverage for Service Groups” on page 117.

 5 Click OK. The new service group is added to the service groups list.
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Creating Requirement Coverage for Service Groups

You use requirement coverage to connect service groups to other 
Quality Center entities (tests, test sets, and defects) through the 
requirement. When you create a service group, you can link it to an existing 
requirement, a new requirement that you create manually, or a default 
requirement that Service Test Management automatically creates for you. 
Alternatively, you can delay linking requirements until after creating a 
service group, and link the group in the Linked Requirements tab. Note that 
you cannot link a service group to a test or test instance until you have 
created requirement coverage. For more information on linking 
requirements in the Linked Requirements tab, see “Linking a Service or 
Service Group to Requirements” on page 146. 

When you link a service group to a requirement, Service Test Management 
creates a Testing requirement type for the service in the Requirements 
module. For more information on requirement types, refer to the 
HP Quality Center User’s Guide.

Linking Service Groups to a New or Existing Requirement
To add requirements coverage to a service group, you can select an existing 
requirement from the requirement tree, or add a new requirement anywhere 
in the tree.

To link a service group to a new or existing requirement:

 1 Perform steps 1-3 of “Creating a Service Group” on page 116.
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 2 In the Requirement linkage section, select the Existing requirement option, 
and click the browse button. The Select Requirement dialog box opens.

 3 To search for a specific requirement in the tree, type the name (or part of the 
name) of the requirement in the Find box and click the Find button. If the 
search is successful, the requirement is highlighted in the tree.

 4 To filter and sort requirements in the tree, click the Set Filter/Sort button. 
For more information on filtering and sorting a tree, refer to the 
HP Quality Center User’s Guide.

 5 To refresh a requirement in the tree, select the requirement and click the 
Refresh Selected button.

 6 To add a requirement folder, click the New Folder button. For more 
information on creating requirement folders, refer to the HP Quality Center 
User’s Guide. 

 7 To add a requirement, click the New Requirement button. For more 
information on creating requirements, refer to the HP Quality Center User’s 
Guide.
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 8 Select a requirement to link to the service group, and click OK. The 
requirement location is displayed in the requirement box.

When you create a service group, Service Test Management creates a link 
between the requirement (in the Requirements module) and the group. 
Requirement coverage for the service group is displayed in the Linked 
Requirements tab.

Linking Service Groups to a Default Requirement
When you create service groups, you can link them to a default requirement 
instead of specifying an existing or new requirement. For each service group, 
Service Test Management creates a requirement with the name 
Default Requirement of Service Group <service group name>(<number>). 

In Project Customization, you can specify a folder in which Service Test 
Management creates default requirements. For information on configuring 
the default requirement folder, see “Customizing the Services Module” on 
page 57.

To link a service group to a default requirement:

 1 Perform steps 1-3 of “Creating a Service Group” on page 116.

 2 In the Requirement linkage section, select the Default requirement option.

 3 Click OK. Service Test Management creates a linked requirement for each 
imported service in the Linked Requirements tab.

Delaying Service Group Requirement Linkage
You can delay linking service groups to requirements until after creating 
service groups. Note that you must link a service group to a requirement 
before you can link it to a test.

To delay service group requirement linkage:

 1 Perform steps 1-3 of “Creating a Service Group” on page 116.

 2 In the Requirement linkage section, select the Link later option.

 3 Click OK. The service group is created without any requirement linkage. 
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 4 After creating a service group, you can create requirement coverage by:

➤ Manually linking service groups to requirements as described in “Linking 
a Service or Service Group to Requirements” on page 146.

➤ Linking service groups to a Default Requirement when you create test 
coverage. For more information on creating test coverage, see “Linking 
Tests to a Service or Service Group” on page 154.

Viewing and Modifying Service Group Details

You can view and modify a service group’s attributes in the Details tab. 

To view or modify service group details:

 1 Click the Service Groups tab in the left pane. The service groups in the 
project are displayed in the service groups list.

 2 Select a service group in the service groups list, and click the Details tab.
120



Chapter 8 • Working with Service Groups
The Details tab contains the following information:

 3 Modify the information as required.

Field Description

Created by The login name of the user who created the service 
group.

Creation date The date that the service group was created in the 
services tree.

Assigned to The user to whom the service group is assigned.

Description A description of the service group.
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Viewing and Modifying Services Assigned to Service Groups

You can view services that are assigned to a service group in the Services tab. 
The Services tab contains a grid that displays information about each 
assigned service, with a link to the service. You can view, add, and delete 
assigned services in the services grid.

To assign a service to a service group:

 1 Click the Service Groups tab in the left pane. The service groups in the 
project are displayed in the service groups list.

 2 Select a service group in the service groups list, and click the Services tab.

The services grid contains the following columns:

Column Description

Address Data Address data for the service.

Address Overridden Indicates whether the service address has been 
overridden.

Assigned To The user to whom the service is assigned.

Authentication 
Default Credentials

“Y“ indicates that the WSDL is accessed using 
authentication default credentials. “N” indicates that the 
WSDL is accessed using an authentication user name and 
password or that no authentication credentials are 
required.
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Authentication User 
Name

The authentication user name for accessing the WSDL on 
a secure site.

Comments Displays comments about the service.

Created By The login name of the user who created the service group.

Creation Date The date on which the service was created. By default, the 
creation date is set to the current database server date. You 
can click the down arrow to display a calendar to select a 
different creation date.

Deleted On The date the service was deleted.

Description A description of the service.

Has changed A description of the service.

Last Updated The time and date the service was last updated.

Original Location The original location of the WSDL file.

Port Type The port type.

Proxy Default 
Credentials

“Y“ indicates that the WSDL is accessed using proxy 
default credentials. “N” indicates that the WSDL is 
accessed using a proxy user name and password or that no 
proxy credentials are required.

Proxy Port The proxy port number.

Proxy Server The proxy server name.

Proxy User Name The user name to access the proxy server

Service Address 
Data

The service address of the endpoint application.

Service Name The service name.

Systinet Key The location of the WSDL file in the Systinet registry.

Systinet Server The service name in the Systinet registry. 

Systinet Server Port The Systinet server port number.

Column Description
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 3 To set column appearance and order in the services grid, click the Select 
Columns button. For more information on arranging columns in a grid, 
refer to the HP Quality Center User’s Guide.

 4 To rename a service group, choose Edit > Rename. Edit the service group 
name and press ENTER.

Systinet Version The Systinet server version. Only a Systinet 2 server with 
Service Pack 1 or later is supported.

Toolkit The name of the Web services toolkit used when 
importing the service.

Type The service type. For example, imported from file, URL, 
UDDI, Systinet, or manual.

UDDI Server The name of the service on the UDDI server.

UDDI Service Key The service key assigned by the UDDI registry.

UDDI Version The version of the UDDI specification. This includes 
Version 2 and Version 3.

Up To Date Indicates whether the service definition from the WSDL 
file is updated each time the service entity is loaded.

Update Time The time at which the service was updated.

Use Authentication Indicates whether authentication credentials are used for 
accessing the WSDL on a secure site.

Use Proxy Indicates whether proxy credentials are used for accessing 
the WSDL.

WSDL Location The source location of the WSDL file.

WSDL Native Name The native service name in the WSDL file.

Column Description
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 5 To assign services to a service group, click the Select button. The services 
tree opens in the right pane.

 6 Select the service you want to assign to the group, and click the Assign 
Service to Service Group button. Alternatively, you can double-click a 
service, or drag a service from the services tree to the services grid. The 
service is added to the services grid.

Tip: A change alert icon  adjacent to a service indicates that the service 
status has changed. This indicates that changes have been made to the 
service, and these changes should be reviewed. For more information on 
viewing service changes, see “Viewing Service Changes” on page 185.

 7 Click the Close Services Tree button in the upper-right of the service 
repository tree to hide the tree.

 8 To remove services from a service group, select the services to remove and 
click the Remove Service from Service Group button in the Services tab. The 
selected services are removed from the services grid. 
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Removing Service Groups

You can delete a service group that is not required from the service groups 
list. Deleting a service group removes the association between the service 
group and its services.

To remove a service group:

 1 Click the Service Groups tab in the left pane.

 2 Select a group from the service groups list, and click the Delete button in the 
toolbar. Alternatively, right-click the service group and choose Delete. The 
service group is removed from the service groups list.
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Generating Service Requirements and 
Tests

You can generate service requirements and tests automatically using the 
Requirement and Test Generation wizard. Alternatively, you can create test 
scripts manually from the Test Plan module of Quality Center.

About Generating Service Requirements and Tests

To test your SOA environment, you can create requirements and tests 
manually, or use the Requirement and Test Generation wizard to 
automatically generate requirements and test scripts.

The Requirement and Test Generation wizard guides you through the 
process of creating requirements and scripts to test your services and service 
groups. Through the wizard, you indicate which aspects of the service you 
want to test. These aspects include interoperability with different toolkits, 
boundary testing, and standard compliance.

This chapter describes: On page:

About Generating Service Requirements and Tests 127

Selecting Testing Aspects 128

Generating Service Requirements and Tests Automatically 130

Manually Creating a Service Test in Quality Center 136

After Generating Requirements and Tests 136
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After you select the testing aspects, Service Test Management automatically 
generates a set of requirements or requirements and tests linked to the 
service or to services in the service group. Only requirements are linked to 
services and service groups. The tests are indirectly linked to services or 
service groups through requirements. These requirements and tests provide 
pre-packaged testing methodologies and service information that specify 
which parts of the SOA environment need to be tested, and what to test in 
each part. 

Generated requirements provide a textual description of the testable feature 
and the expected behavior, based on a template of the specified testing 
aspects adapted to the selected services. Generated tests describe the test 
objective and provide an implementation of that testing objective. They 
include the test operations and arguments for specific testing types. After 
generating requirements and tests, you can customize them to your 
particular requirements. 

You can also link services and service groups to manually created 
requirements, and indirectly to tests through requirements. For more 
information on linking services and service groups to requirements and 
tests, see Chapter 10, “Linking Services to Requirements” and Chapter 11, 
“Linking Tests to Services.”

Selecting Testing Aspects

The Requirement and Tests Generation wizard helps you create 
requirements and tests that verify different aspects of your service. Service 
Test Management creates a separate requirement for each aspect and sub-
aspect, and a separate test for each sub-aspect. It only creates a separate test 
for an aspect if it has no sub-aspects.

Service Test Management supports the following testing aspects:

➤ Positive Testing. Generates a full positive test that checks each operation of 
the service.

➤ Standard Compliance. Checks the service’s compliancy with industry 
standards such as WS-I and SOAP.
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➤ Service Interoperability. Tests the interoperability of the service’s operations 
with all supported Web Services toolkits. Several requirements and tests are 
created for this aspect.

➤ Security Testing. Tests service security using the following techniques:

➤ SQL Injection. Checks if the service is vulnerable to SQL injections by 
injecting SQL statements and errors into relevant parameters. 

➤ Cross-site Scripting. Attempts to hack the service by injecting code into a 
Web site that will disrupt its functionality.

➤ Boundary Testing. Using the negative testing technique, creates tests to 
manipulate data, types, parameters, and the actual SOAP message to test the 
service to its limits.

➤ Null Values. Provides NULL parameters to the services to verify they are 
not accepted. 

➤ Extreme Values. Provides invalid data types to the services and verifies 
they are not accepted. 

➤ Load Testing. (Available for generating requirements only.)

➤ Longevity. Tests that the system can sustain a consistent number of 
concurrent Vusers executing transactions using near-peak capacity, over a 
minimum 24-hour period. 

➤ Scalability. Repeated stress, overload, volume, and longevity tests with 
different server or network hardware configurations.

➤ Volume. Tests that the system can handle a massive data entry. 

➤ Overload (Sustainability). Tests how well the hardware allocated for the 
application can support the number of anticipated users. 

➤ Stress. Tests the maximum load that can be placed on the application.
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Generating Service Requirements and Tests Automatically

The Requirement and Test Generation wizard guides you through the steps 
of creating automatic requirements and test scripts.

To generate service requirements and tests:

 1 Open the Requirement and Test Generation wizard.

➤ For a service, select a service in the services tree, and choose Services > 
Generate Requirements/Tests.

➤ For a service group, select a group in the service groups list, and choose 
Groups > Generate Requirements/Tests.

The Requirement and Test Generation wizard opens.

Read the generation instructions in the welcome page.

Click Next to continue.
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 2 Select the entities you want Service Test Management to generate.

You can generate requirements or requirements and tests.

➤ Generate requirements only. If selected, Service Test Management 
generates a set of requirements linked to the service that provide a 
textual description of the testable feature and the expected behavior, 
based on a template of the specified testing aspects adapted to the 
selected services. 

➤ Generate requirements and tests. If selected (default setting), Service Test 
Management generates a set of requirements (see description above) and 
tests that are indirectly linked to the service through the requirements. 
The tests describe the test objective, based on a template of the specified 
testing aspects adapted to the selected services. Whenever possible, 
generated tests provide an implementation of the test objective by 
describing the test operations.

Click Next to continue.
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 3 Specify the testing aspects you want to cover in the generated entities. 

Available Aspects contains the aspects available for testing. Selected Aspects 
contains the aspects currently selected for requirement and test generation. 
By default, all testing aspects are selected. For more information on the 
testing aspects, see “Selecting Testing Aspects” on page 128.

Using the arrows, move the aspects you want to test from the Available 
Aspects list to the Selected Aspects list. To move all the testing aspects from 
one list to the other, click the double arrow buttons (>> and <<).

Click Next to continue.
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 4 Specify where you want store the generated entities.

To select a storage location for an entity, click Select. The Select <entity> 
dialog box opens. You can search for, filter, sort, and refresh requirements 
and test folders in the requirements/test folder tree. Choose the location in 
Quality Center where you want to store the generated entities.

Notes: 

➤ You can save requirements to existing parent requirements in the 
Requirements module. All generated requirements are added as 
descendants of that parent requirement.

➤ You can save tests to test folders in the Test Plan module. All generated 
tests are added as descendants of this folder. 

➤ The generation process may create additional sub-requirements or 
subfolders and place generated requirements and tests under them.

Click Next to continue.
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 5 Review the generation summary.

The generation settings that you selected are displayed in a read-only 
window. Review the information to make sure you are satisfied with your 
selections.

To select different settings, click Back.

To begin the generation process, click Next.
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 6 View generation progress.

The generation progress is displayed in the progress bar. If Service Test 
Management is unable to create a specific requirement or test, it displays a 
message specifying the nature of the failure. 

Review the generation summary information displayed in the Tasks tab and 
the Errors tab to make sure the generation process completed successfully. 

When the generation process has completed, click Finish to close the wizard.
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Manually Creating a Service Test in Quality Center

You can create service tests in the Test Plan module of Quality Center. 

To create a service test in the Test Plan module, select DB-TEST from the Test 
Type list in the Create New Test dialog box. This creates a service test with a 
basic script that can be viewed, edited, and scheduled for running from 
Quality Center. 

For more information on creating tests, refer to the HP Quality Center User’s 
Guide. For information on viewing and editing service tests, see “Viewing 
and Editing Service Tests” on page 162.

After Generating Requirements and Tests

After the generation process has successfully completed, you can review the 
generated entities in the Linked Requirements and Linked Tests tab. If you 
generated requirements and tests, the requirements are directly linked to the 
service, and the tests are linked to the service through requirement 
coverage.

After generating requirements or requirements and tests, you can do the 
following:

Action Description

Edit the generated 
requirements

You can modify the details, attachments, service coverage, 
test coverage, and defect links for any requirement to suit 
your specific testing objectives. For example, you might 
want to define customized thresholds that are not 
reflected in your service definitions. For more information 
on defining requirements, refer to the HP Quality Center 
User’s Guide.

Edit the generated 
tests

You can use HP Service Test to refine the generated tests to 
expand their scope and purpose. For more information, 
see “Viewing and Editing Service Tests” on page 162. 
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Configure run-time 
settings for test 
instances

You can view the script’s run-time settings, and configure 
run-time settings for test instances in the Test Lab 
module. For more information, see “Configuring Run-
Time Settings from Quality Center” on page 164.

Configure 
parameters for test 
instances

You can configure parameters for test instances in the Test 
Lab module. For more information, see “Configuring Test 
Instance Parameters from Quality Center” on page 167.

Manually link 
requirements

You can manually link requirements to a service or service 
group. For more information on linking services to 
requirements, see Chapter 10, “Linking Services to 
Requirements.”

Manually add test 
coverage

You can manually add test coverage to a service or service 
group. For more information, see Chapter 11, “Linking 
Tests to Services.”

Run the service test You can run the service test. For more information, see 
“Running Service Tests and Viewing Test Results” on 
page 171.

Action Description
137



Chapter 9 • Generating Service Requirements and Tests
138



10
Linking Services to Requirements

Requirements describe what needs to be tested in your application. Each 
service you import to the Services module must be linked to a requirement 
before it can be linked to other entities. You can generate a requirement for 
a service when you create it, or you can link it later in the Linked 
Requirements tab.

About Linking Services to Requirements

Requirement coverage is used to connect services to other Quality Center 
entities (tests, test sets, and defects) through the requirement. This helps 
you keep track of the relationship between your requirements and services, 
and ensures compliance with your requirements throughout the testing 
process. After you have created tests, you associate assigned requirements 
with tests and defects. In this way, you can keep track of your testing needs 
at all stages of the testing process. If a requirement changes, you can 
immediately identify which tests and defects are affected, and who is 
responsible.

This chapter describes: On page:

About Linking Services to Requirements 139

Viewing the Linked Requirements Tab 141

Linking a Service or Service Group to Requirements 146

Deleting Requirement Coverage 147

Viewing the Service Coverage Chart 148
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To test services in Service Test Management, they must first be linked to 
requirements. When you import a service, you can link the service to an 
existing requirement, a new requirement that you create manually, or to a 
default requirement that Service Test Management automatically creates for 
you. Alternatively, you can delay linking to requirements until after the 
import process, and link requirements manually in the Linked 
Requirements tab, or have Service Test Management automatically generate 
requirements for your services and service groups using the Requirement 
and Test Generation wizard (see “Generating Service Requirements and Tests 
Automatically” on page 130). Note that you cannot link a service to a test or 
test instance before it has requirement coverage.

You can manually link requirements by selecting new or existing 
requirements and linking them to a service or service group in the Linked 
Requirements tab. The tab displays a grid containing information about 
each linked requirement, with a link to the requirement.

You can delete a service’s or service group’s requirement coverage. Deleting a 
service’s or service group’s requirement coverage also deletes its test coverage 
and defect linkage.

You can use the Coverage Chart to view the status of requirements linked to 
services and service groups in the Linked Requirements tab.
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Viewing the Linked Requirements Tab

You can view requirements linked to services and service groups in the 
Linked Requirements tab.

To view linked requirements:

 1 Select a service or service group.

 2 Click the Linked Req. tab. The linked requirements grid displays the 
requirements that are linked to the selected service or service group.
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The linked requirements grid contains the following information:

Field Description

Author The user name of the person who created the requirement. By 
default, this is the login user name. 

Comments Displays comments about the requirement.

Creation Date The date on which the requirement was created. By default, 
the creation date is set to the current database server date. 
Click the down arrow to display a calendar and select a 
different creation date.

Creation Time The time at which the requirement was created. By default, the 
creation time is set to the current database server time.

Description A description of the requirement.

Direct Cover 
Status

The current status of the requirement. By default, the status is 
Not Covered.

A requirement status can be one of the following:

➤ Not Covered. The requirement has not been linked to a test.

➤ Failed. One or more tests covered by the requirement have 
an execution status of “Failed”.

➤ Not Completed. One or more tests covered by the 
requirement have an execution status of “Not Completed”.

➤ Passed. All the tests covered by the requirement have an 
execution status of “Passed”. 

➤ No Run. All the tests covered by the requirement have an 
execution status of “No Run”.

➤ N/A. The current status of the requirement is not applicable.

➤ -----. The requirement does not have a direct cover status as 
it belongs to a requirement type that does not support 
coverage.

Modified Indicates the date the requirement was last changed.

Name The requirement name.
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Old Type 
(obsolete)

(formerly Type)

The type of requirement (obsolete). In previous versions of 
Quality Center, the type could be any value configured in the 
project, with typical values Change, Functional, Guideline, 
Quality, Standard, and System.

Note that this field can only be in use for requirements of 
undefined type.

Priority The priority of the requirement, ranging from low priority 
(level 1) to urgent priority (level 5).

Product The component of the application on which the requirement 
is based.

RBQM Business 
Impact

The calculated Business Criticality for the requirement. 
Possible values are A (Critical), B (Important), and C (Nice to 
have). This field is only in use for assessment requirements.

RBQM Custom 
Business Impact

The user-defined custom Business Criticality for the 
requirement. Possible values are A (Critical), B (Important), and 
C (Nice to have). This field is only in use for assessment 
requirements.

RBQM Custom 
Failure 
Probability

The user-defined custom Failure Probability for the 
requirement. Possible values are 1 (High), 2 (Medium), and 
3 (Low). This field is only in use for assessment requirements.

RBQM Custom 
Testing Hours

The user-defined effort required to test the requirement., 
measured in units defined in Project Customization. This field 
is only in use for assessment requirements.

RBQM Custom 
Testing Level

The user defined level at which to test the requirement. 
Possible values are 1-Full, 2-Partial, 3-Sanity, and 4-None. This 
field is only in use for assessment requirements.

RBQM Date of 
Last Analysis

The date a risk-based testing analysis was last performed on the 
requirement. This field is only in use for analysis requirements.

RBQM Effective 
Business Impact

The effective Business Criticality for the requirement. Possible 
values are A (Critical), B (Important), and C (Nice to have). This 
field is only in use for assessment requirements.

Field Description
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RBQM Effective 
Failure 
Probability

The effective Failure Probability for the requirement. Possible 
values are 1 (High), 2 (Medium), and 3 (Low). This field is only 
in use for assessment requirements.

RBQM 
Estimated RnD 
Effort

The user-defined estimate of the effort required to develop the 
requirement. This field is only in use for assessment 
requirements.

RBQM Exclude 
from Analysis

Indicates whether to exclude the requirement from risk 
analysis. A requirement may be excluded from risk analysis if it 
belongs to a type for which risk assessments are not available, 
or if you specifically exclude it from analysis.

RBQM Failure 
Probability

The calculated Failure Probability for the requirement. Possible 
values are 1 (High), 2 (Medium), and 3 (Low). This field is only 
in use for assessment requirements.

RBQM Testing 
Hours

The calculated effort required to test the requirement, 
measured in units defined in Project Customization. This field 
is only in use for assessment requirements.

RBQM Testing 
Level

The calculated level at which to test the requirement. Possible 
values are 1-Full, 2-Partial, 3-Sanity, and 4-None. This field is 
only in use for assessment requirements.

RBQM Use 
Custom 
Business Impact

Indicates whether to use the user-defined Business Criticality, 
instead of the Business Criticality calculated by Quality Center. 
This field is only in use for assessment requirements.

RBQM Use 
Custom Failure 
Probability

Indicates whether to use the user-defined Failure Probability, 
instead of the Failure Probability calculated by Quality Center. 
This field is only in use for assessment requirements.

RBQM Use 
Custom Results

Indicates whether to use the user-defined testing effort and 
testing level, instead of the values calculated by 
Quality Center. This field is only in use for assessment 
requirements.

Req ID A unique alphanumeric ID for the requirement that is assigned 
automatically. Note that the Req ID cannot be modified.

Req Parent The name of the parent requirement.

Field Description
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 3 To set column appearance and order in the linked requirements grid, click 
the Select Columns button. For more information on arranging columns in 
a grid, refer to the HP Quality Center User’s Guide.

 4 To go to a requirement in the requirements tree, click the requirement in the 
linked requirements grid. Alternatively, right-click the requirement and 
choose Go To Requirement in Requirements Tree.

 5 To refresh the requirements in the linked requirements grid, click the 
Refresh button. 

Reviewed Indicates whether the requirement has been reviewed and 
approved by the person responsible.

Requirement 
Type

Indicates the type of requirement. Default values are: 

➤  Business. A business process requirement. By default, 
you cannot add coverage to this requirement.

➤  Folder. A folder for organizing requirements. By default, 
you cannot add coverage to this requirement.

➤  Functional. A system behavioral requirement.

➤  Group. A collection of related requirements.

➤  Testing. A system performance requirement.

➤  Undefined. An undefined requirement.

You can customize the default types and create your own 
requirement types. For more information on customizing 
requirement types, refer to the HP Quality Center Administrator’s 
Guide.

Target Cycle Indicates the cycle in which the requirement was assigned. 
Click the down arrow to select a different cycle.

Target Release Indicates the release in which the requirement was assigned. 
Click the down arrow to select a different release.

Testing Aspect 
Type

The aspects of the service that are tested. These aspects include 
Boundary testing, Expected behavior test, Load testing, 
Security testing, Service interoperability, and Standards 
compliance.

Field Description
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Linking a Service or Service Group to Requirements

You can manually link a service or service group to requirements in the 
Linked Requirements tab.

To link a service or service group to requirements:

 1 Select a service or service group, and click the Linked Req. tab.

 2 In the Linked Requirements tab, click the Select button to open the 
requirements tree in the right pane.

 3 To search for a specific requirement in the tree, type the name (or part of the 
name) of the requirement in the Find box and click the Find button. If the 
search is successful, the requirement is highlighted in the tree.

 4 To filter and sort requirements in the tree, click the Set Filter/Sort button. 
For more information on filtering and sorting a tree, refer to the 
HP Quality Center User’s Guide.

 5 To refresh a requirement in the tree, select the requirement and click the 
Refresh Selected button. 
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 6 Select a requirement or requirement topic to link to the service or service 
group: 

➤ Click the Add to Coverage (Without Children) button to add the 
requirement without the requirement’s child requirements. Alternatively, 
double-click the requirement.

➤ Click the Add to Coverage arrow and choose Add to Coverage (Include 
Children) to add the requirement, including its child requirements.

The requirement is added to the linked requirements grid.

Tip: You can also link requirements by dragging a requirement from the 
requirements tree to the linked requirements grid. The requirement is added 
to the linked requirements grid without its child requirements.

 7 Click the Close button to hide the requirements tree.

Deleting Requirement Coverage

You can delete a service’s or service group’s requirement coverage. Deleting a 
service’s or service group’s requirement coverage also deletes its test coverage 
and defect linkage.

To delete requirement coverage

 1 Select a service or service group whose requirement coverage you want to 
remove.

 2 Click the Linked Req. tab.

 3 In the linked requirements grid, select the requirements to delete, and click 
the Remove Selected button. Click Yes to confirm.

The links between the selected requirements and the service or service group 
and all its related entities are removed.
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Viewing the Service Coverage Chart

You can view the status of requirements linked to services and service 
groups in the Linked Requirements tab of the Services module.

Service coverage is displayed in the form of a pie chart report.

To view the service coverage chart:

 1 In the Services module, select a service or service group with linked 
requirements, and click the Linked Reqs. tab.

 2 Click the Show button on the lower-right of the Linked Requirements tab to 
display the Coverage Chart for the service. The Coverage Chart is displayed.

The Coverage Chart is a pie chart that graphically displays the requirements 
coverage for the service, grouped according to test status.

 3 To hide the Coverage Chart, click the Hide button on the lower-right of the 
Linked Requirements tab.
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Linking Tests to Services

To test the quality and performance of your services, you generate tests and 
link them to your services and service groups through requirement 
coverage.

 

About Linking Tests to Services

Tests describe the test objective and an implementation of the testing 
objective. They include the test operations and the expected outcome of 
each test. You can generate tests and link them to your services and service 
groups through requirements coverage, or you can instruct Service Test 
Management to generate a set of tests that are automatically linked to 
services or service groups through requirements (see Chapter 9, “Generating 
Service Requirements and Tests”).

This chapter describes: On page:
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Linking Tests to a Service or Service Group 154

Removing Test Coverage 158
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To link tests manually, after you create a service and link requirements to 
the service, you can link the requirements to tests in the Test Plan module or 
Requirements module. Alternatively, you can link tests by selecting tests and 
linking them to a service or service group in the Linked Tests tab of the 
Services module. Note that a service must have requirement coverage before 
it can be indirectly linked to a test. For more information on linking 
requirements to services, see “Creating Requirement Coverage for Services” 
on page 86. 

Note: You can also create coverage between test instances and services or 
service groups. You can enable this feature using the 
ALLOW_REQ_COVERAGE_BY_TEST_INSTANCE parameter in Site 
Administration. For more information on this parameter, refer to the 
HP Quality Center Administrator’s Guide.

You can view, edit, add, and delete test linkage in the linked tests grid. You 
can also view and add test linkage to services in HP Service Test scripts that 
are stored in Quality Center’s Test Plan module.

Viewing the Linked Tests Tab

You can view tests linked to services and service groups in the Linked Tests 
tab. The Linked Tests tab contains the following tests grids:

➤ Covering tests. Displays tests linked to the service that are aimed at 
validating the service’s functionality. This linkage is manually defined by 
the user.

➤ Using tests. Displays tests with a script based on the service, that call one or 
more operations of the service. These tests are created in HP Service Test and 
stored in Quality Center. To link Using tests to a service’s requirements 
coverage, you must select the test and add it to coverage.
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To view linked tests:

 1 Select a service or service group.

 2 Click the Linked Tests tab to view the Covering tests grid (on top) and the 
Using tests grid (below). 

The Covering tests grid contains the following information:

Column Description

Entity Name The linked entity name.

Entity Status The current status of the entity.

Coverage Type The description of the test (Test for a test and Test 
Instance for a test instance in a test set).

Plan: Subject The subject folder in the test plan tree in which the test 
resides.

Plan: Comments Displays comments about the test.
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Plan: Creation Date The date on which the test was created. By default, the 
creation date is set to the current database server date. 
Click the down arrow to display a calendar and select a 
different creation date.

Plan: Description A description of the test.

Plan: Designer The name of the test’s designer.

Plan: Estimated 
DevTime

The time estimated to design and develop the test.

Plan: Execution 
Status

The current execution status of the test.

Plan: Modified The date and time of the last change to the test.

Plan: Path The path of this test relative to the Tests directory in the 
server repository.

Plan: Status The planning status of the test. The default status is 
Design.

Plan: Template Indicates whether the manual test or QuickTest 
Professional test is a test template. The value in this 
column is “Y” if the test is a test template, or empty if it is 
not. For more information on manual template tests, refer 
to the HP Quality Center User’s Guide.

Plan: Test Name The name of the test, and a link to the test in the test plan 
tree or test sets tree.

Plan: Testing Aspect 
Type

The aspects of the service that are tested. These aspects 
include Boundary testing, Expected behavior test, Load 
testing, Security testing, Service interoperability, and 
Standards compliance.

Plan: Type The type of test. For example, MANUAL or WinRunner.

Column Description
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The Using tests grid contains the following additional information:

 3 To set column appearance and order in the Covering tests grid or the Using 
test grid, click the Select Columns button. For more information on 
arranging columns in a grid, refer to the HP Quality Center User’s Guide.

 4 To go to a test in the test plan tree, click the test link in the Covering tests 
grid. Alternatively, right-click the test and choose Go To Test in Test Plan 
Tree.

 5 To go to a test in the Test Lab module, right-click the test in the Covering 
tests grid and choose Go To Test in Test Set.

 6 To refresh the tests in the Covering tests grid or Using tests grid, click the 
Refresh All button.

Column Description

Test ID A unique numeric ID for the test, assigned automatically 
by Quality Center. The Test ID is read-only.
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Linking Tests to a Service or Service Group

After you create a service and link requirements to the service, you can link 
the requirements to tests in the Test Plan module or Requirements module. 
When you link a requirement, all tests already linked to that requirement 
are Covering tests of the service (they are displayed in the Covering tests 
grid for the service).

You can also link tests to a service or service group in the Linked Tests tab by 
adding them from the test plan tree to the Covering tests grid. Covering 
tests are aimed at validating the service’s functionality, and the linkage is 
manually defined by the user.

To link tests to a service or service group, select one or more tests from the 
test plan tree. You can link tests to a service or service group only if the 
service has requirements coverage. If a service or service group does not 
have requirement coverage, Service Test Management lets you link the 
service or service group to a default requirement, which is covered by the 
test.

In addition, you can link Using tests to a service or service group. These are 
tests with a script based on the service, that call one or more operations of 
the service. These tests, which are created in HP Service Test and stored in 
Quality Center, are displayed in the Using tests grid of the Linked Tests tab. 
Note that some tests in the Using tests grid might use services that do not 
cover functionality, such as logging on services, that you might not want to 
include in the test coverage.
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To link tests to a service or service group:

 1 Select a service or service group, and click the Linked Tests tab.

 2 In the Linked Tests tab, click the Select button to open the test plan tree in 
the right pane.

 3 To search for a specific test in the tree, type the name (or part of the name) 
of the test in the Find box and click the Find button. If the search is 
successful, the test is highlighted in the tree.

 4 To filter and sort tests in the tree, click the Set Filter/Sort button. For more 
information on filtering and sorting a tree, refer to the HP Quality Center 
User’s Guide.

 5 To refresh a test in the tree, select the test and click the Refresh Selected 
button.
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 6 Select a test or test folder to link to the service or service group. Click the 
Add to Coverage button. The Link <test_name> to Requirement dialog box 
opens displaying the requirements linked to the service.
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 7 Select a requirement option for linking to the test or tests in a test folder. If a 
test folder contains more than one test, all the tests are linked to the service 
or service group through the same requirement.

➤ Default Requirement. Creates a link between the default service 
requirement and the test or tests in a test folder. The linked requirements 
grid is not available when you select this option. If a service has no 
requirement coverage, you must select this option to create requirement 
coverage for a service or service group. If the default requirement does 
not exist, Service Test Management creates a default requirement and 
links it to the selected test or tests in a test folder. 

➤ Linked Requirement. Enables you to specify which service requirement to 
link to the test or tests in a test folder. Select a requirement from the 
linked requirements grid. This option is not available if the service or 
service group has no linked requirements. 

To set column appearance and order in the linked requirements grid, click 
the Select Columns button. For more information on arranging columns in 
a grid, refer to the HP Quality Center User’s Guide.

To refresh the linked requirements grid, click the Refresh button.

Click OK. The test is added to the Covering tests grid.

If you select a test folder, only tests that match your current filter are added 
to the test linkage.

Tip: You can also link tests by dragging a test or test folder from the tree to 
the Covering tests grid.

 8 Click the Close button to hide the test plan tree.

 9 To add a Using test to a service’s or service group’s requirements coverage, 
select a test in the Using tests grid and click the Add To Coverage button. 
The test is added to the Covering tests grid.
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Removing Test Coverage

You can delete a service’s test coverage from the Linked Tests tab. Tests are 
linked to services and service groups through requirement coverage, and 
removing requirement coverage may remove links to other tests. In 
addition, removing a test from requirement coverage may remove test 
coverage for all other services and service groups linked to the requirement.

Tip: Before you remove a service’s test coverage, make sure that you do not 
remove coverage from other requirements and from services linked to these 
requirements that you do not want to remove.

To remove test coverage:

 1 Select a service or service group whose test coverage you want to remove.

 2 Click the Linked Tests tab.

 3 In the Covering tests grid, select the test you want to remove.

 4 Click the Remove from Coverage button to remove the selected test. 
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Note: If deleting the selected test affects test coverage for other entities, the 
following confirm box opens.

Deleting test coverage removes coverage from the listed requirements, and 
from services linked to these requirements.

Click Yes to confirm you want to remove test coverage.

The links between the selected test and the requirements (the ones which 
make it a covering test of this service), are removed. Links between 
requirements and services are unaffected.
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12
Running Service Tests

After you have generated service tests, you can edit the tests and test 
configuration settings to suit your specific testing objectives. You can then 
create and run test sets containing services, and view service test results.

This chapter describes: On page:

About Running Service Tests 162

Viewing and Editing Service Tests 162

Configuring Run-Time Settings from Quality Center 164

Configuring Test Instance Parameters from Quality Center 167

Creating Tests Sets 170

Running Service Tests and Viewing Test Results 171
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About Running Service Tests

After generating tests, you can modify the details, attachments, service 
coverage, test coverage, and defect links for any test to suit your specific 
testing objectives. You can also view the script’s run-time settings and 
customize the way the Vuser script is run. If a script has parameters, you can 
assign values to them, or change the existing parameter values from within 
Quality Center. Note that you can view and customize run-time settings and 
parameters for a test instance in the Test Lab module only.

Before you run service tests, you create test sets containing these service 
tests. You can then run service tests and view results in the Test Lab module 
of Quality Center. You can run service tests individually, or you can run 
them as part of a test set containing multiple tests of all types.

When you run a service test, HP Service Test opens and runs the test under 
the test configuration. When the test finishes, Service Test reports the test 
results back to Quality Center, and saves them as part of the test run.

Viewing and Editing Service Tests

After generating service tests, you can view the test script in the 
Quality Center Test Plan module. If you have installed Service Test on your 
machine, you can edit tests to suit your specific testing objectives. You can 
add and remove service operation invocations, update argument data, add 
validation steps on service responses, and configure security and attachment 
data.

You edit tests using Service Test depending on your installation. You can 
open a generated test for editing by launching Service Test for the generated 
test from Quality Center, or by opening Service Test, and connecting to the 
Quality Center project to access the generated test. For more information on 
connecting to Quality Center from Service Test and using Service Test to 
modify service scripts, refer to the HP Service Test User’s Guide.
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To view or edit a service test:

 1 Click the Test Plan module button, and select a service test in the test plan 
tree.

 2 Click the Test Script tab to view the test script.

 3 Click the Launch button to open the test script in Service Test. You can edit 
the script directly in the tool and save the changes.

Note: When you run the script in Service Test, the results are not reflected in 
Service Test Management.
163



Chapter 12 • Running Service Tests
Configuring Run-Time Settings from Quality Center

You can view the script’s run-time settings and customize the way the Vuser 
script is run in the Configuration view of the Test Lab module. When you 
override a script’s run-time settings from Quality Center, the modified 
settings are saved to the test in Quality Center and do not affect the settings 
in the Service Test script.

To configure the script’s run-time settings from Quality Center:

 1 Click the Test Lab module button, and select the Execution Grid. 

 2 Select a service test, and click the Test Instance Properties button. 
Alternatively, choose Tests > Test Instance Properties. The Test Instance 
Properties dialog box opens.
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 3 In the Test Instance Properties dialog box, click Configuration on the sidebar 
and click the Automated tab.
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 4 In the Run-Time Settings section, click Run-Time Settings. The Run-Time 
Settings dialog box opens.

The Run-Time Settings dialog box displays the settings that you set using 
Service Test. If you did not set run-time settings for a script, the default 
Service Test settings are displayed.

For information on each specific run-time setting, refer to the HP Service Test 
User’s Guide.

Modifying the run-time settings affects only the test settings in 
Quality Center. When you modify run-time settings, they are saved for each 
test within the test plan and do not overwrite the files inside the script.

 5 Click OK to close the Run-Time Settings dialog box and save the changes.

Note: To restore the initial settings, in the Test Instance Properties dialog 
box, click Restore From Script.
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 6 Click OK to close the Test Instance Properties dialog box and return to the 
Execution Grid. 

 7 Run the test or test set. If you modified the run-time settings in 
Quality Center, the script runs using the modified settings. 

Configuring Test Instance Parameters from Quality Center

You can take a script that has test instance parameters, and assign values to 
them, or change the existing parameter values from within Quality Center. 
Since the script is saved in Quality Center, you do not need to change the 
script each time your replay it. You override the parameter values set in a 
script from the Configuration view of the Test Lab module.

To change test instance parameters:

 1 Click the Test Lab module button, and select the Execution Grid.

 2 Select a service test, and click the Test Instance Properties button. 
Alternatively, choose Tests > Test Instance Properties.
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 3 In the Test Instance Properties dialog box, click Configuration on the sidebar 
and click the Automated tab.
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 4 In the Parameters section, click Parameter List. The Parameter List dialog 
box opens.

You can view and edit the value of each parameter. Any changes that you 
make to a parameter value are implemented in the next test run.

Note: Changing a parameter value affects all test sets using the test.

For more information on working with parameters, refer to the HP Service 
Test User’s Guide.

 5 Click OK to close the Parameter List dialog box and save the changes.
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 6 To restore the initial settings, in the Test Instance Properties dialog box, click 
Restore From Script.

 7 Click OK to close the Test Instance Properties dialog box. 

 8 Run the test or test set. If you modified the parameters in Quality Center, 
the script runs using the modified settings.

Creating Tests Sets

After you have created service tests, you create test sets in the Test Lab 
module and choose which tests to include in each set. A test set is a group of 
tests in a Quality Center project designed to achieve specific testing goals.

Suppose you want to test a service to ensure it functions properly. You also 
want to use the same test sets as a basis for subsequent versions of the 
service after a change has been made to a service. In the test sets tree, you 
can create the folder Calc_Service1.0 for the first version of a calculator 
service and add tests sets. Each test set contains tests for checking a specific 
component of the application, for example, standard compliance, 
interoperability, security and so on.

For details on creating test sets, refer to the HP Quality Center User’s Guide.
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Running Service Tests and Viewing Test Results

Once you have defined test sets, you can begin executing the tests. You can 
run these test sets in Quality Center’s Test Lab module. For details on 
running test sets, refer to the HP Quality Center User’s Guide.

After you have run the test sets, you can verify the service behavior and 
analyze the results in various formats:

➤ View a report for each script action and a replay log from the Execution 
Grid. For more information, see “Viewing the Test Results Report and Log 
File” on page 172.

➤ View the results using Quality Center graphs, reports, and documents. For 
more information, refer to the HP Quality Center User’s Guide.

➤ View service level status through requirement coverage. For more 
information, see “Viewing the Service Coverage Chart” on page 148.

➤ Generate Excel reports that enable you to analyze service and service group 
data from within Excel. For more information, see “Generating Excel 
Reports” on page 109.
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Viewing the Test Results Report and Log File
After you run a test set, you can view a summary of the test results using the 
Test Results viewer. The viewer also shows the results of the checkpoints. 
You can also view a replay log of the test run. 

To view the Test Results report:

 1 Click the Test Lab module button, and select the Execution Grid.

 2 Click the Launch Report button. Test results for each script action are 
displayed in the Test Results viewer.
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Test results are divided into iterations, actions, and steps.

The results report marks a successful step with a green check mark and a 
failed step with a red X. An iteration is only marked as successful if all of its 
steps and actions have succeeded.

For Web Service calls, the lower pane of the Results window displays the 
contents of the SOAP response.

The Results window also shows checkpoint results. It provides a summary 
with a reason for the failure. It also provides the Expected Value and Actual 
Results.
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To view the checkpoint details, expand the appropriate step in the left pane 
and click the Checkpoint node.

For more information about working with test results, refer to the HP Service 
Test User’s Guide.

To view the replay log: 

 1 Click the Test Lab module button, and select the Execution Grid.

 2 Click the View Replay Log button. The test’s replay log is displayed in a text 
editor. You can examine the messages in the replay log to see whether the 
test ran without errors.
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Viewing Linked Defects

You can create defects and link them to tests or requirements that cover the 
service or service group. You can then view defects linked to your services 
and service groups and track the progress of defect resolution.

About Viewing Linked Defects

Service Test Management does not support direct links between services and 
defects. Instead, defects are indirectly linked to services and service groups 
through requirements. After you create defects and link them to a test or 
requirement that covers the service or service group, you can view these 
linked defects in the Linked Defects tab of the Services module. Defect 
linkage is useful, for example, when a new test is created specifically for a 
defect. By creating this linkage, you can determine whether the test should 
be run based on the status of the defect.

When you link a requirement to a service or service group, Service Test 
Management adds a direct link to the requirement and indirect links to any 
defects linked to the requirement and to defects linked to tests covered by 
the requirement.

This chapter describes: On page:

About Viewing Linked Defects 175

Viewing Defects Linked to Services or Service Groups 176
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Viewing Defects Linked to Services or Service Groups

The Linked Defects tab enables you to display the defects that are linked to 
the currently selected service or service group. The tab displays a grid 
containing information about each linked defect, with a link to the defect. 
You can view and modify defect details in the linked defects grid. 

Note: Service Test Management does not support direct links between 
services and defects. Only defects directly linked to requirements that are 
linked to a service or service group are displayed in the Linked Defects tab.

The linked defects grid contains the following columns:

Column Description

Actual Fix Time Indicates the actual number of days needed to fix the 
defect. If this field is left blank, Quality Center 
automatically calculates the Actual Fix Time as Closing 
Date - Detected on Date.

Assigned To The user name of the person who is assigned to fix the 
defect. Click the down arrow to display a list displaying 
the name and full name of each user. 
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Closed in Version Indicates the application version in which the defect was 
closed. Click the down arrow to display a list of versions.

Closing Date Indicates the date on which the defect was closed. Click 
the down arrow to display a calendar and select a closing 
date.

Comments Displays comments about the defect.

Defect ID A unique numeric ID for the defect, assigned 
automatically by Quality Center. Click the Defect ID link 
to open the defect in the Defects module. The Defect ID is 
read-only.

Description Describes the defect in detail.

Detected By The user name of the person who found the defect. By 
default, Quality Center inserts the login user name into 
this field.

Detected in Cycle Indicates the cycle in which the defect was detected. Click 
the down arrow to select a different cycle.

Detected in Release Indicates the release in which the defect was detected. 
Click the down arrow to select a different release.

Detected in Version Indicates the application version in which the defect was 
detected. Click the down arrow to display a list of 
versions.

Detected on Date The date on which the defect was detected. By default, the 
current database server date is displayed. Click the down 
arrow to select a different detection date.

Estimated Fix Time Indicates the estimated number of days required for fixing 
the defect.

Modified Indicates the date and time when this defect was last 
changed.

Planned Closing 
Version

Indicates in which version the defect is planned to be 
fixed. Click the down arrow to display a list of versions.

Priority The priority of the defect, ranging from low priority 
(level 1) to urgent priority (level 5).

Column Description
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To set column appearance and order in the grid, click the Select Columns 
button. For more information on arranging columns in a grid, refer to the 
HP Quality Center User’s Guide.

To filter, sort, and group defects in the grid, click the Set Filter/Sort button. 
For more information on filtering, sorting, and grouping a grid, refer to the 
HP Quality Center User’s Guide.

To refresh the grid, click the Refresh button.

For more information on viewing linked defects, refer to the 
HP Quality Center User’s Guide.

Project The name of the project where the defect occurs. Click the 
down arrow to display a list of projects.

Reproducible Indicates whether the defect can be recreated under the 
same conditions by which it was detected. Click the down 
arrows to choose Y or N.

Severity The severity of the defect, ranging from low (level 1) to 
urgent (level 5).

Status The current status of the defect. By default, the status is 
New. Defect status can be one of the following: Closed, 
Fixed, New, Open, Rejected, Reopen. 

Subject Indicates the subject folder. Click the down arrow to 
display a list of subjects.

Summary A brief summary of the defect.

Target Cycle Indicates the cycle to which the defect was assigned. Click 
the down arrow to select a different cycle.

Target Release Indicates the release to which the defect was assigned. 
Click the down arrow to select a different release.

Column Description
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Updating Services and Analyzing Service 
Changes

Change impact analysis helps you minimize the risk of changes in SOA 
environments by detecting changes to services and establishing their 
impact.

This chapter describes: On page:

About Using Change Impact Analysis 180

The Service Change Workflow 181

Updating Services and Service Groups 182

Viewing Service Changes 185

Creating Test Sets 189

Running Test Sets 191

Updating the Change and Service Status 192
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About Using Change Impact Analysis

Change impact analysis helps you assess the impact of changes to services in 
your service tests. When you update a service or service group, Service Test 
Management compares the latest definition from the WSDL file to the 
WSDL definition stored in Quality Center. If there are changes at the 
operation signature level or in the data structure of an argument, Service 
Test Management lists these changes in the Changes tab. For each change, 
Service Test Management displays a description of the change, an 
assessment of the change-risk, and the change status. It also flags the 
changed service in the services tree and the Services tab (if the service is 
assigned to service groups).

To verify the changes, you can create test sets containing all tests linked to 
the updated service, or only those tests that are using service operations 
affected by the changes. Each test set must be linked to a requirement that 
covers the service. If a service does not have requirement coverage, Service 
Test Management lets you link the service to a default requirement, which is 
covered by the test set. All tests in a test set are linked to a service through 
the requirement.

After creating a test set, you can run the linked or affected tests in the test 
set to verify whether these changes caused regression in service 
functionality and performance. You can also trace changes to any linked 
requirements, tests, test sets, and defects. This enables you to immediately 
identify which entities are affected, and who is responsible for them.
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The Service Change Workflow

The Service Change Workflow is an explanation of the steps involved in 
testing service changes. By default, it is displayed in the right pane of the 
Changes tab.

The Service Change Workflow contains the following steps:

 1 Update a service.

Update the service definition stored in Quality Center with the latest 
definition from the WSDL file. Service Test Management flags the changed 
service in the services tree and Services tab. For more information, see 
“Updating Services and Service Groups” on page 182.

 2 Review the changes in the service.

Review the changes in the Changes tab, and determine the severity of the 
change based on the change type, change description, and change risk. For 
more information, see “Viewing Service Changes” on page 185.

 3 Analyze impact of change on linked tests.

Evaluate the tests that are currently linked to the service in the Linked Tests 
tab, and add additional tests if necessary. For more information on tests 
linked to services, see “Viewing the Linked Tests Tab” on page 150.

 4 Create regression test sets to check the changes.

Create a test set folder for the test sets in the Test Lab module, and then 
create test sets containing the tests you want to run to verify these changes 
in the Changes tab. For more information, see “Creating Test Sets” on 
page 189.

 5 Run the test sets.

Run the test sets from the Quality Center Test Lab module. For more 
information, see “Running Test Sets” on page 191.

 6 Update the status of the changed service according to run results.

Verify the behavior of the changed service and update the change status in 
the Changes tab. For more information on change status, see “Viewing 
Service Changes” on page 185.
181



Chapter 14 • Updating Services and Analyzing Service Changes
 7 View service coverage.

After all changes have been successfully tested, review the coverage in the 
Linked Req. tab. For more information, see “Viewing the Service Coverage 
Chart” on page 148.

 8 Update the change status.

When you are satisfied with the quality of a service, remove the service 
change alert. For more information, see “Updating the Change and Service 
Status” on page 192.

Updating Services and Service Groups

You use the update service or update group services features to check for 
changes in a service or group of services. If changes are found in the service 
WSDL file, the service definition and operations data stored in 
Quality Center is updated. You can update the service from the latest WSDL 
file located at the same location from which the service was imported, or 
from a different location if the WSDL file was moved. If you update the 
service from a different file location, you must update the service from the 
same location type that was originally used (file, URL, UDDI, or Systinet).

You can also update WSDLs that reside on secure locations and WSDLs 
accessed through proxy servers provided the correct authentication 
credentials have been supplied. For more information on authentication 
and proxy settings, see “Accessing Services on Secure Sites and Proxy 
Servers” on page 90.

You can update individual services from the Service Repository tab, or all 
services in a service group from the Service Groups tab. When you update a 
service, Service Test Management displays changes in the Changes tab for 
the selected service, and flags the changed service in the services tree and 
Services tab. For more information, see “Viewing Service Changes” on 
page 185.
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Note: If Keep up to date is selected in the Details tab, the service definition 
is automatically updated from the WSDL file each time the service is loaded.

To update a service or services in group:

 1 Select the service or service group you want to update in the services tree or 
service groups list. Use Ctrl or Shift to select more than one service.

 2 Choose one of the following update options:

➤ To update a service using the same WSDL location, choose Services > 
Update Service > Update Service. 

➤ To update services in a service group using the same WSDL location, 
choose Groups > Update Group Services. You cannot update services in a 
service group using different WSDL locations.

➤ To update a service using a different WSDL location, choose Services > 
Update Service > Update Service from, and select the WSDL you want to 
update from.

Note: When updating a service from a UDDI or Systinet server, the selected 
service must have a WSDL file whose definition has the same service name 
as the original WSDL used to import the service. You can only select a single 
service to use as the new source for the import.
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 3 The Update Service dialog box opens and the update process begins. Service 
Test Management checks for changes in the WSDL file and informs you if 
the service was updated.

To automatically close the Update Service dialog box after the update 
process has finished, select Close dialog box when process finishes.

By default, Quality Center pauses the process each time it finds an error, and 
displays the error message in the Import Services dialog box. To continue 
with the import process, click Continue, or click Stop to end the process. If 
you do not want to view errors during the import process, clear the Pause on 
error check box.

 4 To stop the update process at any time, click Stop.

 5 When the update process is finished, click Finish to close the Update Service 
dialog box.
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Tip: If a service is updated, Service Test Management displays a service 
change alert icon  next to the service in the services tree and in the 
Services tab (for services assigned to groups), and in the Changes tab for the 
selected service.

 6 Click the service’s Changes tab to view change details. For more 
information, see “Viewing Service Changes” on page 185.

Viewing Service Changes

You can view changes to a service in the Changes tab. Service Test 
Management displays a service change alert icon  in the Changes tab. This 
indicates the service status has changed, and that the service should be 
reviewed.

The changes grid displays information about each service change, including 
a description of the change, the part of the WSDL file and service affected by 
the change, the change status, and an assessment of the change-risk. In 
addition, you can modify and delete service changes from the changes grid.
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To view service changes:

 1 Select a service that has been updated. A service change alert icon  next to 
a service in the services tree or Services tab (for services assigned to groups), 
indicates that a service has been updated and contains changes.

 2 Click the Changes tab. The changes grid lists the changes that were made to 
the service.
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The changes grid contains the following information:

Column Description

Change Risk The business risks and costs associated with the change. A 
change can have one of the following risk levels:

➤  High. Changes that are likely to affect functionality 
and fail any test that is not updated. High-risk changes 
include operation removal and parameter changes.

➤  Medium. Changes may affect functionality, but 
may not necessarily fail existing tests. Medium-risk 
changes include service changes (notification that 
some of the service files have changed).

➤  Low. Changes are unlikely to fail or affect existing 
functionality or implemented tests. Low-risk changes 
include operation additions (as they do not affect 
existing functionality), service address changes 
(deployment only), and port type changes.

Change Status The current status of the change. By default, the change 
status is New.

Update the status throughout the change analysis process 
as follows:

➤ New. There is a change in the service.

➤ In test. The change is being tested.

➤ Verified. The change was tested and did not cause a 
regression.

➤ Obsolete. The change does not affect the service.

Change Type The type of change is indicated as follows:

➤ Added. A service operation was added.

➤ Removed. A service operation was removed.

➤ Updated. Changes were made to the argument 
structure of the operation. Details of these changes are 
displayed in the Description column.

Created By The user name of the person who run the update that 
created the changes.

Creation Date The date on which the change was made. By default, the 
creation date is set to the current database server date.
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 3 To display an explanation of the steps involved in testing service changes, 
click the Show Help Panel button in the upper-right part of the Changes tab. 
Click the button again to hide the panel. For more information, see “The 
Service Change Workflow” on page 181.

 4 To display the description of the change in a separate pane, click the Show 
Description button in the lower-right part of the Changes tab. The 
Description pane is displayed below the changes list. Click the button again 
to hide the pane.

 5 To delete a change from the changes grid, click the Remove Selected button. 
To delete more than one change, hold down the CTRL key and select the 
changes you want to delete, then click the button.

 6 To set column appearance and order in the grid, click the Select Columns 
button. For more information on arranging columns in a grid, refer to the 
HP Quality Center User’s Guide.

 7 To refresh a change in the grid, select the change and click the Refresh 
button.

Creation Time The time at which the change was made. By default, the 
creation time is set to the current database server time.

Description A description of the service change and suggested tests to 
verify. 

For service operation changes (where Part Type is 
Operation and Change Type is Updated), the change 
description contains details of the argument that was 
added or removed from the operation.

Owner The user name of the person who is responsible for the 
service.

Part Name The part of the WSDL file affected by the change.

Part Type The part of the service affected by the change (Operation, 
Service, or Port).

Severity The severity level of the change, determined by the user 
(High, Medium, Low).

Column Description
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 8 To filter, sort, and group changes in the grid, click the Set Filter/Sort button. 
For more information on filtering, sorting, and grouping a grid, refer to the 
HP Quality Center User’s Guide.

 9 To create a test set to verify service changes, click the Create Test Set arrow, 
and select a test set creation option as described in “Creating Test Sets” on 
page 189.

 10 To hide the service change alert icon, choose Services > Service Change 
Alert. This removes the icon from the Changes tab, services tree, and 
Services tab in the service groups grid (if the service is assigned to a service 
group). To redisplay the service change alert icon, select Services > Service 
Change Alert.

Creating Test Sets

After reviewing changes in a service and evaluating the tests affected by the 
change, you can create test sets to verify the changes. You can create one or 
more test sets containing the tests you want to run. This enables you to 
perform specific tests for the detected changes. If necessary, you can reduce 
the total testing effort required by selecting only the tests affected by these 
changes. You create test sets in the Changes tab.

Each test set must be linked to a requirement that is linked to a service or 
service group. If a service or service group does not have requirement 
coverage, Service Test Management lets you link the service or service group 
to a default requirement, which is then linked to the test set. All test 
instances in a test set are linked to a service or service group through the 
requirement.
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To create a test set:

 1 Click the Changes tab, and select the service for which you want to verify 
changes.

 2 Click the Create Test Set arrow, and select a test set creation option:

➤ Include all tests. Creates a test set that includes all tests covering the 
service. This does not include test scripts that used some of the service 
operations if they were not linked to the service. The Create Test Set With 
All Tests dialog box opens.

➤ Include affected tests only. Creates a test set that only includes tests 
covering the service that were affected by the selected changes. Service 
Test Management detects the test scripts that are using service operations 
affected by the change. The Create Test Set For Selected Changes dialog 
box opens.

For more information on covering and using tests, see “Viewing the Linked 
Tests Tab” on page 150. 

Note: Only affected tests that have change status New are included in the 
test set.

 3 The Create Test Set With All Tests/For Selected Changes dialog box opens.
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 4 In the Test Set folder box, select the folder under which you want to save 
the test set you are creating. Note that you cannot add a test set directly to 
the Root folder. If you have not created a test set folder for the test set, click 
Cancel and create the folder in the Test Lab module.

 5 In the Test set name box, you can accept the default name 
<service_name>_TestSet_<date>, or type a name for the test set, and click 
OK.

 6 In the Requirement linkage section, select a requirement to link to the test 
set.

➤ Existing requirement. Enables you to specify which service requirement 
to link to the test set. You can link the test set to a new or existing 
requirement. For more information, see “Linking Services to a New or 
Existing Requirement” on page 87. This option is not available if the 
service or service group has no linked requirements.

➤ Default requirement. Creates a link between the default service 
requirement and the test set. If the service or service group has no linked 
requirements, you must select this option to create requirement coverage 
for the service or service group. Service Test Management creates a 
default requirement and links it to the test set.

 7 Click OK. Service Test Management creates a test set containing the tests you 
selected.

Running Test Sets

After you create test sets to test the impact of changes made to services in a 
SOA environment, you can run these test sets in Quality Center’s Test Lab 
module. After you have run the test sets, you can verify the service behavior 
and analyze the test results using Quality Center graphs, reports, and 
documents. For details on running test sets and analyzing test results, refer 
to the HP Quality Center User’s Guide.

After all changes have been tested, review the coverage status of the parent 
requirement created for the changes set in the Linked Requirements tab, and 
verify the changes. For more information, see “Viewing the Service Coverage 
Chart” on page 148.
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Updating the Change and Service Status

After all the changes have been successfully tested and you are satisfied with 
the quality of a service, you can update the status for each change, and 
remove the service change alert icon.

To update the change and service status:

 1 Select an updated service in the services tree, and click the Changes tab.

 2 In the changes grid, select the change whose status you want to update.

 3 Click in the Change Status column, and click the Change Status arrow. 
Select a change status:

➤ If the change was tested and did not cause a regression, change the status 
to Verified.

➤ If the change does not affect the service, change the status to Obsolete.

 4 Repeat steps 2-3 for each service change.

 5 To remove the service change alert icon for the service, choose Services > 
Service Change Alert. This removes the change icon from the Changes tab, 
services tree, and Services tab (if the service is assigned to service groups). 
Select Services > Service Change Alert again to redisplay the service change 
alert icon.
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Integration with HP Service Test

HP Service Test integrates with Service Test Management to let you create 
tests and emulated services to check and assess the quality of applications 
and services in your SOA systems.

Creating Tests with HP Service Test

Service Test Management works together with Service Test to provide an 
efficient method for storing and retrieving Vuser scripts, scenarios or session 
steps, and collecting results. You store Service Test scripts in a Quality Center 
project and organize them into unique groups. Using Service Test, you 
create tests for your Web services, edit tests generated using Service Test 
Management, run tests, view results, and reuse services. 

For more information on working with Service Test, refer to the HP Service 
Test User’s Guide.

This chapter describes: On page:

Creating Tests with HP Service Test 193

Creating a Service Emulation 194

Using Emulated Services in Vuser Scripts 203

Emulating Services from Quality Center 205
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Creating a Service Emulation

Service Test provides a Service Emulation tool for creating an emulation of a 
service to test other Web services in your environment.

The emulated service lets you design and run tests at early stages of 
development when the actual service is inaccessible. For example if the 
development of the service is incomplete or if the service’s host is 
unavailable, you can use an emulated service to test other services in your 
application.

In the Service Emulation interface, you associate a WSDL document to the 
service which indicates its operations and parameters. You specify rules and 
delays to define the service’s behavior.

The steps in creating an emulated service are:

➤ Starting the Emulation Server

➤ Troubleshooting the Server

➤ Selecting a Host

➤ Adding a New Service

➤ Setting the Emulated Service’s Behavior

➤ Manipulating Emulated Services

Starting the Emulation Server
The Server Emulation tool provides a Tomcat server through which you can 
run emulated services. The installation program installs an Axis servlet that 
allows you to run the service on the Tomcat server running on the local 
machine. 

To create or run emulated services on your local machine, you must 
manually start the emulation service.

To start the emulation service:

Choose Start > Programs > HP Service Test > Start Emulation Service.
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To stop the emulation service:

Choose Start > Programs > HP Service Test > Stop Emulation Service.

You can also manually start and stop the service from the Services dialog 
box (Start Programs > Administrative Tools > Services). The service is called 
Mercury ServiceEmulation.

To check whether or not the server is active, enter the following URL into 
your browser: http://localhost:8080/ServiceEmulation/index.jsp.

Troubleshooting the Server
If the Service Emulation console indicates that the server is not accessible, 
even after a manual start, you can try the following troubleshooting tips: 

➤ Make sure the server is up. Enter the following URL into your browser: 
http://localhost:8080/ServiceEmulation/index.jsp. If the server is down, start it 
manually from the Start menu.

➤ Verify that port 8080 is available. If it is not, release the port and restart the 
server.

➤ Open the Apache Tomcat log files under the <product install dir>\Service 
Test\apache-tomcat-5.5.17\logs directory and determine the reason that the 
server did not load. Fix the problem and reload the server.

➤ When emulating a service, if you encounter a warning “Service is not 
activated” in the endpoint location of your emulated service, perform one 
or more of the following actions:

➤ Verify that the service is active. Select the service in the left pane and 
click the Activate Service button in the right pane, if it is visible.
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➤ If the service is already active, check its URL. Copy the URL from the 
WSDL Location in the Emulated Service’s right pane, and paste it into a 
browser, removing the suffix ?wsdl from the string. For example, instead 
of http://localhost:8080/axis/services/MyService?wsdl, use 
http://localhost:8080/axis/services/MyService. If your browser opens a valid 
page, then your service is active. To use this emulated service, import the 
original WSDL into Service Test. Then override the address and set it to 
the URL you previously used in the browser.

For more information about integrating your emulated service into your 
test, see “Using Emulated Services in Vuser Scripts” on page 203.

Selecting a Host
The first step in creating an emulated service is choosing a host for the 
emulated services. The setup installs a Tomcat server on your local machine. 
You can also specify external servers, upon which the Tomcat server is 
installed.

By default, the Service Emulation tool uses localhost as the emulation server.

To add an external host:

 1 Open the Service Emulation tool. Choose Start > Programs > HP Service Test 
> Service Emulation Console. 

Tip: You can also open the Service Emulation tool from Quality Center 
Services module by choosing Tools > Run Service Emulation Console.

 2 Choose Main > New Host or click the Add Host button to open the Select 
Host dialog box.
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 3 Browse for a host in your network, or enter the host name directly. If 
applicable, change the port setting from the default value, 8080.

 4 Click OK. The host is added to the list in the window‘s left pane.

Adding a New Service
For each host that you added, you can create emulated services. You create a 
service by specifying a WSDL file that defines the operations and parameters 
of the service. When you specify a WSDL file, the Service Emulation tool 
uses the current structure of the WSDL to define the structure of the service’s 
input and output data. 

If the original WSDL changes, it is not reflected in your emulated service. To 
use an updated WSDL, recreate the emulated service.

To define a new service:

 1 Choose Main > New Emulated Service or click the New Emulated Service 
button to open the Create a New Emulated Service dialog box.

 2 Enter the full path or URL of the WSDL in the WSDL Location box, or click 
the Browse button to the right of the box, to locate the WSDL.

 3 Choose a host from the list, or click New Host to add a new one.
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 4 Click Create to add the new service. All services are listed in the window’s 
left pane.

 5 To delete a specific service, select it in the left pane and choose Delete from 
the right-click menu.

Setting the Emulated Service’s Behavior
The Service Emulation lets you specify a behavior for each of the operations 
defined in the WSDL.You specify the behavior of the service’s operations by:

➤ Providing the Default Response

➤ Setting Rules

Providing the Default Response

The default response is the default values that you expect the operation to 
provide. 

You can manually specify the values for the default response, or you can 
import them from an XML file containing sample results.

To specify a default response:

 1 Expand the service and desired operation in the left pane.
198



Appendix A • Integration with HP Service Test
 2 Select the Default Response node of your service. The right pane shows a 
Default Response table.

 3 In the Values column, specify a default response value.

 4 To import values from captured traffic, click Import from Traffic.

 5 Select the XML file with the desired traffic and click OK.

 6 To instruct the service to use the default response values, click Reset Values.

Setting Rules

In addition to setting the default response, you can also set behavior rules. 
Through rules, you define a distinct behavior for the service—the expected 
response based on the request, input data. 

You can set the rules manually, or by importing them from an existing XML 
SOAP file.

To set rules manually, you insert values for one or more of the arguments 
and the corresponding response. For example, for an add operation, you 
could specify 4 as the first argument, 5 as the second argument, and a result 
of 9.
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If necessary, you can exclude a specific argument. This is useful if you want 
your service to return a particular response, ignoring the value of one of the 
arguments. For example, for a multiplication operation, you can set a rule 
indicating that if the first argument is 0, the results are 0, regardless of the 
value of the second argument.

You can set multiple rules for your operation. You place the rules in order of 
priority—the higher rules have priority over the lower ones in case of a 
conflict. In the following example, Rule 3 has the highest priority.

To set a rule manually:

 1 Expand the service and desired operation in the left pane.

 2 Select the operation in the left pane and click the New Rule button or 
choose Add New Rule from the right-click menu.

 3 Specify values for the request and response.

 4 Select the check boxes adjacent to each of the arguments that you want to 
impact the rule.

 5 Click Save to save all of the modifications you made to the service.
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 6 To import values from a SOAP file, click Import SOAP and specify an XML 
file containing the SOAP message. You can import SOAP messages for both 
the request and the response.

 7 For additional rules, repeat the above steps.

 8 To move a rule up to raise its priority, use the Move Rule Up button or right-
click and choose Move up.

 9 To move a rule down, use the Move Rule Down button or right-click and 
choose Move down. 

Manipulating Emulated Services
After you create your emulated services you can manipulate them by:

➤ Reloading an Emulated Service

➤ Inserting Delays for Operations

➤ Deactivating and Activating a Service

Reloading an Emulated Service

Reloading emulated services reverts to the last saved version of the service 
on the host. Any rules that were not saved are lost. If another user saved 
changes to the service from a different machine, by reloading the service, 
you will bring those changes on to your machine. 

This feature is useful if you made changes and you want to discard them and 
revert back to the saved version. Another use for this feature is if another 
user modified the service behavior, you can reload the service to get their 
changes. 

To reload a service:

 1 Select the service you want to reload.

 2 Click the Reload button or choose Reload from the right-click menu.
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Inserting Delays for Operations

To more accurately emulate a service, you can insert a delay time for the 
response of each operation. This delay emulates a delay in the response of 
the server after the application submitted a request.

To insert a delay:

 1 Select an operation in the left pane.

 2 In the right pane, enter the delay in seconds.

Deactivating and Activating a Service

After you create a service, you can deactivate it temporarily instead of 
deleting it. If you deactivate a service, it is ignored in your tests, but it is still 
available if you need to implement it in the future.

In the list of emulated services, a green box indicates that a service is active 
and a red box indicates that it not active. 

To deactivate a service, select it in the left pane and click the Deactivate 
Service button or click Deactivate Service in the right pane.

To activate a service that was previously deactivated, select it in the left pane 
and click the Activate Service button or click Activate Service in the right 
pane.
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Using Emulated Services in Vuser Scripts

After you create an emulated service, you can import it into your Vuser 
script for testing purposes.

To use an emulated service:

 1 Select a service in the left pane and copy the Endpoint location from the 
right pane to the clipboard.

 2 Open the Service Management window, and click the Service Management 
button or choose SOA Tools > Service Management.

 3 Select the service that you want to emulate.
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 4 Enable the Override address option.

 5 Paste the Endpoint location into the Service address box. During the test 
run, the service will respond to that location.
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Emulating Services from Quality Center

After you create rules for an emulated service, you can emulate the service 
from Quality Center by choosing a host for the emulated service. You can 
only emulate a service on a machine that has a Service Emulation client.

To select a host from Quality Center:

 1 Open the Service Emulation tool. In the Quality Center Services module, 
choose Tools > Emulate Service. The Specify Service Emulation Host dialog 
box opens.

 2 In the Service Emulation Host Name box, enter the host name. 

 3 In the Port box, enter the port number.

 4 Click OK to emulate the service on the host machine.

Quality Center attempts to contact the emulation host and create an 
emulated service. A message is displayed if the service is successfully 
emulated or if an error occurs during emulation. If the emulation completed 
successfully, Quality Center overrides the service address to the emulated 
service address. This allows any script testing that service to run using the 
emulated service.
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